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1 About the program

1.1 What does the program do?

This program calculates the emission from various types of vehicles such as trucks,
automobiles, motorcycles, buses etc. The calculation is based on data regarding fleet
and fuel characteristics, meteorological data and the chosen policy regarding pollution.

The program is capable of handling any number of runs and scenarios. The
calculations are based on the well-known Mobile 6.2 model of EPA.

In particular, the program can calculate the concentrations of hydrocarbons, carbon
monoxide, nitrogen oxides and carbon dioxide. The following particulates are also
calculated: Sulfur oxides (SO2, SO4), lead, ammonia, brake-wear, tire-wear etc.

Finally, the following air toxics are calculated: benzene, methyl-tertiary-butyl ether,
1,3 butadiene, formaldehyde, acetaldehyde, acrolein.

NOTE: Due to the complexity of the model, detailed information is provided in the
following separate manuals:

C:\Program Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35
\UserGuide.pdf
C:\Program Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35
\SensitivityAnalysis.pdf
C:\Program Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35
\TechnicalGuidance.pdf

1.2 Data input

The following steps must be followed for proper data input:

1. Enter the general data.
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2. Add at least one run.
3. Add at least one scenario.
4. The following data are required:

Year
Fuel vapor pressure RVP

5. Enter the rest of the data.

Some data may be entered in both runs and a scenarios. The program will attempt to
apply the data to the run. If this is not possible, it will attempt to apply the data to
the scenario. When no data are found, default values are used.

1.3 Minimum requirements

The minimum requirements for the usage of the programs are the following:

Windows 2000/ XP/ 2003/ Vista/ 7 (for each case, the latest service packs,
updates & patches must be installed)
Pentium III 800 MHz
800x600 with 256 color palette
700 MB free disk space
CD-Rom

If your system does not meet one or more of the above requirements, it is highly
recommended that you upgrade it before installing the programs. The recommended
system configuration is the following:

Windows 2000/ XP/ 2003/ Vista/ 7 (for each case, the latest service packs,
updates & patches must be installed)
Pentium IV 2.0 GHz
1280x768 with 16-bit color palette
1.2 GB free disk space
CD-Rom
Internet connection

1.4 Technical support

Support through the Internet

TechnoLogismiki offers technical support 24 hours per day, 365 days per year, through
the web site where you can get information on the latest programs and services.

Support by e-mail

Please use the dedicated e-mail addresses for better customer service:

for questions regarding sales: sales@technologismiki.com
for questions regarding the usage of programs: support@technologismiki.com
for any other question or comment: info@technologismiki.com

The normal response time is within two business days. If your inquiry cannot be
answered by e-mail, a customer service representative will contact you by telephone.

Interactive Support
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Business days, 09:00 - 17:00 Eastern European Time:

Telephone [3 lines]: ++30-210-656-4147
Fax: ++30-210-654-8461
Address: 5, Imittou street, Cholargos, 15561, Athens, Greece.
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2 File

2.1 File menu

With this menu, you can perform file operations and print reports. In the File menu
you can select one of the following options:

New Project
Open Project
Save Project
Save Project As
Import
o Mobile 6.x Input File

o Mobile 5.x Input File

Export
o Mobile 6.2 Input File

Print Setup
Print
Print To
o Print to File

o Print to Word

o Print to Word (Formatted)

o Print to Excel

Exit

2.2 New Project

With this option, a new project is started. All data, results, graphs, titles etc. of the
previous project are erased.

To create a new project:

1. Select New project from the File menu.
2. If a project is already loaded and changes have been made, a warning message will
appear that asks the user whether to save the changes or not.
3. The current project is erased and a new project is started.

2.3 Open Project

With this option, an existing project is loaded. The project may be located locally, in a
network or in an external media device such as a CD-Rom. If a project is already
loaded and changes have been made, a warning message will appear that asks
whether to save the changes or not. When a project is loaded, all data of the previous
project are lost.

To open an existing project:

1. Select Open project from the File menu.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Mobile Emission project" with the extension .m35.
4. Select the file by clicking on it.
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5. Select Open to open the selected file. Select Cancel to cancel the operation.

NOTE: You can find sample projects in the installation folder of the program:
C:\Program Files\TechnoLogismiki\TLW20132\Samples\MobileEmission

Supported file types

Μ35 (Mobile Emission project): Files created by version 2012 and 2013 of Mobile
Emission.
Μ135 (Mobile Emission project): Files created by versions 2011, 2010, 2009, 2008
or 2007 of Mobile Emission.
BCK (Backup files): If you have selected from program options the creation of
backup copy when a file is loaded, then the file can be loaded by selecting Backup
files (*.bck) from the Files of type drop-down list.
*.* (All files): Displays all files in the current folder.

NOTE: If a message "Could not load project. File may be corrupt or saved by an
unknown or incompatible version of the program" then either you are  trying to load a
project that does not belong to this program or the file is used (and locked) by
another process in your computer.

2.4 Save Project

With this option, you can save all data of a project into a file. The file may be saved
locally, in a network location or in an external media device such as a disk.

The filename and path will be asked only the first time you are saving a project. When
the filename and path are set, all subsequent saves will be made to the same file.

When you want to rename a file or save it in a new location, use Save project as...
from the File menu.

To save the current project:

1. Select Save project from the File menu.
2. If the location of the file is already set, the project is saved to this file without any
messages. If the filename is not set, a dialog box will appear that allows the selection
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of the filename and path.

2.5 Save Project As

With this option, the current project is saved just as in the case of Save project, but
with the difference that the name and/or location of the file can be changed. In this
way, you can create backup files or move a project to another media device.

To save a project with another name and/or to another location:

1. Select Save project as from the File menu.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the project with the selected filename and path. Select Cancel
to cancel the operation.

NOTE: If a file with the same name and in the same path already exists, a warning
message will appear that asks whether to overwrite the file or not. If you answer Yes,
then the existing file is erased and the new file takes its place. If you answer No, the
existing file remains intact but NO changes of the current project are saved.

2.6 Import

2.6.1 Mobile 6.x Input File

With this option, you can import data from an input file created for Mobile 6.0, 6.1, or
6.2 model. Any existing data will be overwritten. 

To import data from an input file created for Mobile 6.0, 6.1, or 6.2 model:

1. Select Import from the File menu.
2. Select Mobile 6.x Input File from the Import menu. The following form appears:
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3. Select the path of the file.
4. Select the file type from the Files of type drop-down list. The default option is
"Mobile 5.x Input File" with the extension .in.
5. Select the file by clicking on it.
6. Select Open to open and analyze the file. If one or more problems or warnings
occur during import, a form containing detailed information appears:

2.6.2 Mobile 5x Input File

With this option, you can import data from an input file created for Mobile 5.0 model.
Any existing data will be overwritten. All compatible data are transferred to the Mobile
6.2 format; any incompatible data are ignored.

To import data from an input file created for Mobile 5.0 model:

1. Select Import from the File menu.
2. Select Mobile 5.x Input File from the Import menu. The following form appears:



Mobile Emission18

© 2012 TechnoLogismik i

3. Select the path of the file.
4. Select the file type from the Files of type drop-down list. The default option is
"Mobile 5.x Input File" with the extension .in.
5. Select the file by clicking on it.
6. Select Open to open and analyze the file. If one or more problems or warnings
occur during import, a form containing detailed information appears:

NOTE: The direct use of Mobile 5.0 projects is not recommended, as the latest model
(6.2) is far more sophisticated and improved.

2.7 Export

2.7.1 Mobile 6.2 Input File

With this option, you can create a file that can be used by Mobile 6.2. 

To create a file that can be used by Mobile 6.2:

1. Select Export from the File menu.
2. Select Mobile 6.2 Input File from the Export menu. The following form appears:



File 19

© 2012 TechnoLogismik i

4. Select Ok to proceed with the export. Select Cancel to cancel the operation.
5. The file selection form appears:

6. Select the path of the file.
7. Type the filename in the File name text box.
8. Select Save to create the file. Select Cancel to cancel the operation.

2.8 Print setup

With this option, you can select which parts of the project will be included in the
printouts. When a new project is created, a full report is selected by default.

To modify the print setup:

1. Select Print setup from the File menu.
2. Select the sections (Title, Project information etc) that will be printed for each
solution, from the list on the left.
3. Select the solutions that will be included in the report from the list on the right.
4. Check Use new page for each object if you want to use a new page for each
solution in the report.
5. Check Repeat headers for data/results if you want to repeat the headers when
large tables span multiple pages.
6. Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.
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The quick keys (Select all, Select None, Select Invert) can be used to quickly select
all objects, deselect all objects and invert the current selection of a list.

NOTE: The changes are saved with the project. The above preferences are used to all
printouts, either to the printer or to other formats such as Word file, Excel file etc.

2.9 Print

With this option, you can prepare a report to be printed to a local, network or virtual
printer such as Adobe PDF Writer. The parts of the project that will be included in the
report are determined from print setup.

By selecting Print, the report is not printed directly; instead, a document is prepared
and a preview of the printout is created by the Print manager. You can print the
report by clicking the Print button of the toolbar of Print manager.

To create a report:

1. Select Print from the File menu.
2. A report is prepared and sent to Print manager. A preview of the document
appears.
3. You can print the report by clicking the Print button of the toolbar.
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NOTE: A complete user manual on the capabilities of Print manager can be found in
the corresponding help file.

2.10 Print to

2.10.1 Print to File

With this option, you can create a simple text file containing a report of the project.
This file is recognized and can be further modified by word processors such as
Microsoft Word, OpenOffice Writer etc.

To print to a text file:

1. Select Print to from the File menu.
2. Select Print to file from the Print to menu.
3. Select the path of the file.
4. Type the filename in the File name text box.
5. Select Save to create the file.
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The parts of the project that will be included in the report are determined from print
setup.

NOTE: If a file with the same name and in the same path already exists, a warning
message will appear that asks whether to overwrite the file or not. If you answer Yes,
then the existing file is erased and the new file takes its place. If you answer No, the
existing file remains intact but the report is NOT printed.

2.10.2 Print to Word

If Microsoft Word (version 97, 2000, XP, 2003 or later) has been installed in the
system, then a Microsoft Word file containing the report can be created. Note that
Microsoft Word is a separate program and it is not included in TechnoLogismiki's
products. Moreover, no technical support is offered regarding the usage of Microsoft
Word.

To print the report to a Microsoft Word file:

1. Select Print to from the File menu.
2. Select Print to Word from the Print to menu.

The parts of the project that will be included in the report are determined from print
setup.

2.10.3 Print to Word (Formatted)

If Microsoft Word (version 97, 2000, XP, 2003 or later) has been installed in the
system, then a Microsoft Word file containing the report can be created. Note that
Microsoft Word is a separate program and it is not included in TechnoLogismiki's
products. Moreover, no technical support is offered regarding the usage of Microsoft
Word.

To print the report to a formatted Microsoft Word file:

1. Select Print to from the File menu.
2. Select Print to Word (Formatted) from the Print to menu.

The parts of the project that will be included in the report are determined from print
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setup. This operation is much slower than the regular print to word function. However,
the final output requires minimal user intervention as it comes fully formatted with
tables, alignment, font styles, etc.

NOTE: Do not use Copy (CTRL+C) on any of the programs running during this
operation. If you do so, it will most likely affect the communication between Microsoft
Word and the clipboard and as a result the final document will be corrupt.

2.10.4 Print to Excel

If Microsoft Excel (version 97, 2000, XP, 2003 or later) has been installed in the
system, then a Microsoft Excel file containing the report can be created. Note that
Microsoft Excel is a separate program and it is not included in TechnoLogismiki's
products. Moreover, no technical support is offered regarding the usage of Microsoft
Excel.

To print the report to a Microsoft Excel file:

1. Select Print to from the File menu.
2. Select Print to Excel from the Print to menu.

The parts of the project that will be included in the report are determined from print
setup.

2.11 Exit

With this option, you can exit the program. If there are changes in the current project
that have not been saved then the program will:

either ask the user to save the changes
or save the changes
or ignore the changes

depending on what you have selected in General preferences.

To exit the program:

1. Select Exit from File menu.
2. If you are asked whether to save the changes or not, you can save changes or
ignore them.
3. The program is terminated.
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3 Data

3.1 Data menu

With this menu, you can add and modify data. In the Data menu you can select one
of the following options:

Project Info
Undo
Redo
Project Properties
Add Run
Delete Run
Change Run
Add Scenario
Delete Scenario
Change Scenario
Units
o Metric System

o English

Options
o General Preferences

o Grid Editing

o Customize Toolbar

3.2 Project Info

With this option, you can add project information that include, optionally, title, author
and comments. If you want, this information can be included in the reports. The
empty fields are ignored.

To add or modify the project information:

1. Select Project info from the Data menu.
2. Type the project title, author and comments.
3. Check Include project time and date if you want to include the time and date in
the project.
3.1. Type the day, month, year, hours and minutes in the corresponding text boxes.
Alternatively, you may click on the up/down arrows to increase or decrease the
respective value in the text box.
3.2. If you click on Now then all text boxes are filled with the current values
automatically.
4. Check Include the name of the project file if you want the full path and filename
of the project to be included in the report.
5. Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.
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By selecting the buttons with the ellipses (...) next to the project title and author, you
can access the corresponding databases.

Project title database

For the completion of a project, more than one programs may be needed. For
convenience, you can add the project title to the database and retrieve it from all
programs.

To use the project title database:

1. Select the button with the ellipses (...) next to the project title text box. The project
title database appears.
2. Select Add to add a new title to the database.
3. Select Remove to remove the selected entry from the database. You will be asked
for confirmation only if you have selected to confirm deletions in the General
preferences tab.
4. Select Edit to modify the selected entry.
5. Select Ok to use the currently selected project title and close the dialog box. Select
Cancel to close the dialog box without applying any changes.

Author database
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An engineer may be involved in multiple projects. For convenience, you can add the
author name to the database and retrieve it from all programs.

To use the author database:

1. Select the button with the ellipses (...) next to the author text box. The author
database appears.
2. Select Add to add a new author to the database.
3. Select Remove to remove the selected entry from the database. You will be asked
for confirmation only if you have selected to confirm deletions in the General
preferences tab.
4. Select Edit to modify the selected entry.
5. Select Ok to use the currently selected author and close the dialog box. Select
Cancel to close the dialog box without applying any changes.

3.3 Undo

Undo cancels the last committed change in the project.

To cancel the last committed change:

1. Select Undo from the Data menu.
2. The last committed change is canceled.

To cancel an undo command, you may use the redo function which is described
below. Redo becomes available once undo is used.

It is possible to undo more than one recent changes and to redo them, by following
the step described above. The number of actions that are kept in memory and may be
undone or redone is 20 by default. This means that the program is able to keep track
of up to 20 successive changes and undo them. This number may change for all
programs, using the option in the main menu. For more information, please consult
main menu user guide.

NOTE: Some changes cannot be undone like the new project or the save project
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functions.

3.4 Redo

Redo cancels the latest undo command.

To redo the latest change that was undone:

1. Select Redo from the Data menu.
2. The latest undone change is redone.

To undo a redo, you may use the undo command.

It is possible to redo more than one changes that were previously undone by following
the steps described above. The number of actions that are kept in memory and may
be undone or redone is 20 by default. This means that the program is able to keep
track of up to 20 successive changes that are undone and redo them. This number
may change for all programs, using the option in the main menu. For more
information, please consult main menu user guide.

3.5 Project Properties

With this option, you can modify the properties of the project.

To modify the properties of the project:

1. Select Project Properties from the Data menu. The project properties form
appears.

In the Pollutants Tab:

2. Select the pollutants that will be taken into account. The quick keys (Select all,
Select None, Select Invert) can be used to quickly select all objects, deselect all
objects and invert the current selection. Select Default to restore the default
selection.

In the Particulates Tab:
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2. Select the particulates that will be taken into account. The quick keys (Select all,
Select None, Select Invert) can be used to quickly select all objects, deselect all
objects and invert the current selection. Select Default to restore the default
selection.

In the Air Toxics Tab:

3. Select the air toxics that will be taken into account. The quick keys (Select all,
Select None, Select Invert) can be used to quickly select all objects, deselect all
objects and invert the current selection. Select Default to restore the default
selection.
4. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

3.6 Add Run

With this option, you can add a run to the project. Optionally, this can be a copy of
another existing run.

To add a run to the project:

1. Select Add Run from the Data menu. The following form appears:
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2. Enter a unique name for the run.
3. Optionally, enter comments.
4. If you wish to create a copy of an existing run, select it from the drop-down list.
5. Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.

3.7 Delete Run

With this option, you can delete an existing run from the project.

To delete an existing run from the project:

1. Select the run to be deleted from the list in the main form.
2. Select Delete Run from the Data menu. You will be asked for confirmation only if
you have selected to confirm deletions in the General preferences tab.
3. Select Yes to proceed with the deletion. Select No to cancel the operation.

NOTE: If a run contains one or more scenarios, these are deleted as well.

3.8 Change Run

With this option, you can modify the contents of an existing run.

To modify the contents of an existing run:

1. Select the run to be modified from the list in the main form:
2. Select Change Run from the Data menu. The following form appears:

3. Make the appropriate modifications.
4. Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.



Data 31

© 2012 TechnoLogismik i

3.9 Add Scenario

With this option, you can add a scenario to a run. Optionally, this can be a copy of
another existing scenario, either of the same run or of another.

To add a scenario to a run:

1. Select Add Scenario from the Data menu. The following form appears:

2. Select the run to which the new scenario belongs using the drop-down list.
3. Enter a name for the scenario.
4. Optionally, enter comments.
5. If you wish to create a copy of an existing scenario, select it from the drop-down
list.
6. Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.

NOTE:
A run may contain one or many scenarios.
A scenario always belongs to a run. You cannot add a scenario if there is no run
defined.

3.10 Delete Scenario

With this option, you can delete an existing scenario from a run.

To delete an existing scenario from a :

1. Select the scenario to be deleted from the list in the main form.
2. Select Delete Scenario from the Data menu. You will be asked for confirmation
only if you have selected to confirm deletions in the General preferences tab.
3. Select Yes to proceed with the deletion. Select No to cancel the operation.

3.11 Change Scenario

With this option, you can modify the contents of an existing scenario.

To modify the contents of an existing scenario:

1. Select the scenario to be modified from the list in the main form:
2. Select Change Scenario from the Data menu. The following form appears:
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3. Make the appropriate modifications.
4. Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.

3.12 Units

3.12.1 Metric System

With this option, the metric unit system is used for both the input data and the
results.

To use the metric unit system:

1. Select Units from the Data menu.
2. Select Metric System from the Units menu. The metric unit system is used.

3.12.2 English

With this option, the English unit system is used for both the input data and the
results.

To use the English unit system:

1. Select Units from the Data menu.
2. Select English from the Units menu. The English unit system is used.

3.13 Options

3.13.1 General preferences

With this option, you can modify the general preferences of the program.

To modify the general preferences:

1. Select Options from the Data menu.
2. Select General preferences from the Options menu.
3. The general preferences dialog box appears. The preferences are grouped into four
tabs. You can select a tab by clicking on its name.

General Tab
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This tab contains general preferences regarding the usage of the program.

Check Register the extension *.m35 with this application to associate the
extension .m35 with this program. This extension is used by the program when saving
a project. In this way, you will be able to run the program and load a project by
double-clicking on the project filename in Windows Explorer.

Check Automatically display calculation messages if you want the report details to
be automatically displayed when you calculate the results.

Check Automatically create backup file if you want a backup file (with the
extension .bck) to be created every time a project is loaded. By default, this file is
created in the temporary folder of Windows.

Check Confirm delete actions if you want to be asked for confirmation each time an
object is about to be deleted. This setting affects the behaviour of all delete actions,
for example the deletion of an object.

You can also modify the temporary folder that will be used for the creation of backup
files. By default, this folder is the temporary folder of Windows.

Finally, there are three options regarding the termination of the program:

When exiting always ignore changes - All changes since the last save of the
project are ignored. 
When exiting always save changes - All changes in the current project are
automatically saved. If the filename of the project is not set, a dialog box will
appear that allows the selection of the filename, as when selecting Save project
as from the File menu.
When exiting prompt for action - If there are changes in the current project,
then a dialog box will appear. You can choose to save or ignore the changes. If
the filename of the project is not set, a dialog box will appear that allows the
selection of the filename, as when selecting Save project as from the File menu.

Languages Tab
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If more than one language packs have been installed, then you can choose the
language of the program. In the above case, there are two language packs; English
(that are already selected) and Greek. If you change the language, all forms, menus,
messages, help files will reflect the chosen language.

In order for the changes to take effect, you must restart the program.

Digits Tab

With this tab, you can modify the way the results are presented. All values used in the
program are displayed in the list on the left.

For each value, you can select the number of decimal digits using the Number of
digits drop-down list.

Check Use 0.1 instead of .1 to use a preceding zero when displaying numbers
between -1 and 1, for example -0.08 instead of -.08 and 0.98 instead of .98.

Check Use 1.0 instead of 1 to use trailing zeros (when necessary) in order to display
a number with the decimal digits selected in the Number of digits drop-down list, for
example 1.1600 instead of 1.16 (when the number of digits is set to 4).

Internet Tab
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The program can automatically check for newer versions over the Internet. Check 
Automatically check for newer versions to enable this feature. The check is
automatically performed at an interval specified in the Every drop-down list. Select
Check now to manually check for newer versions.

When a newer version is found, you will be prompted to download and install the
latest version.

NOTE: TechnoLogismiki protects your privacy. During the check for newer versions,
no data is transferred from your computer to the Internet.

Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.

3.13.2 Grid editiing

With this option, you can modify the behavior of grids.

The behaviour of all editable grids is controlled by the preferences in this dialog box.

Select No cell automation if you want the active cell to remain the same when
hitting ENTER.

Select Open the cell below (edit by columns) if you want to activate the cell below
when hitting ENTER. This is particularly useful when editing tables by columns.

Select Open the next cell (edit by rows) if you want to activate the next cell on the
right when hitting ENTER. This is particularly useful when editing tables by rows.

In some cases, the program may automatically fill some missing values (for example,
when performing linear interpolation). In this case, you can select a distinctive color in
order to recognize these values. You can choose the color by clicking on the button in
the Auto-complete settings frame.

NOTE: These preferences affect all projects, old and new.
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Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.

3.13.3 Customize toolbar

With this option, you can customize the toolbar of the main form.

To customize the toolbar of the main form:

1. Select Options from the Data menu.
2. Select Customize toolbar from the Options menu.
3. Make the appropriate changes.
4. Select Ok to apply the changes and close the dialog box. Select Cancel to close the
dialog box without applying any changes.

The toolbar may contain small or large buttons.

Check Show description if you want a small description to be displayed under the
buttons.

Check Show tooltips if you want tooltips to be displayed when the mouse pointer
hovers over a button for 2-3 seconds.

NOTE: These preferences affect all projects, old and new.



Chapter

IV
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4 Pollutants

4.1 Pollutants menu

This menu is used to enter and manage all data relevant to pollutants. In particular,
the following options are offered via this menu:

Particulate emission factors
o Gasoline vehicle age classes

o Gasoline vehicle zero kilometer level

o Gasoline vehicle deterioration (1-age)

o Gasoline vehicle deterioration (age-25)

o Diesel vehicle age classes

o Diesel vehicle sulfur

o Diesel vehicle zero kilometer level

o Diesel vehicle deterioration (1-age)

o Diesel vehicle deterioration (age-25)

Particle size limit
Hydrocarbon emissions speciation
No refueling emissions
User defined air toxic pollutants
o Add air toxic pollutant

o Delete air toxic pollutant

o Change air toxic pollutant

o Clear all records

o Import from file

o Export to file

Fuel economy data

4.2 Particulate emission factors

4.2.1 Gasoline vehicle age classes

For the 15 gasoline vehicles categories, enter the ages (from 1 to 25) that will be used
to separate the gasoline vehicle deterioration. For example, if for the LDGV category
the value 10 is entered, then the deterioration will be taken into account for vehicles
between 1 to 10 years old and 10 to 25 years old. If the age is set equal to 1 or 25,
one of the two deterioration categories will be obsolete.

To edit the gasoline vehicle age classes:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Gasoline Vehicle Age Classes.
4. The ages are directly entered in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.2.2 Gasoline vehicle zero kilometer level

The zero kilometer level (or mile for English units) of gasoline vehicles is the pollutant
emission of brand new gasoline vehicles, which are entered in grams per km per
10000 km (metric system) or in grams per mile per 10000 miles (English units).

For each of the 15 gasoline vehicles categories, the values from 1950 to 2020 of the
emitted pollutants are required, for all brand new vehicles that operate with:

Leaded fuel, without catalyst and without air injection
Unleaded fuel, without catalyst and without air injection (1st generation catalyst
vehicles)
Unleaded fuel, with catalyst, but no air injection
Unleaded fuel, with catalyst and with air injection

To edit the gasoline vehicle zero kilometer level:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Gasoline Vehicle Zero Kilometer Level.
4. Select a decade from the drop-down list.
5. Enter the zero kilometer level for each combination.
6. Repeat steps 4 and 5 until all data have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.2.3 Gasoline vehicle deterioration (1-age)

The gasoline vehicle deterioration quantifies the effect of vehicle aging of the emission
control mechanism to the pollutant emission. The deterioration is entered in grams per
km per 10000 km (metric system) or in grams per mile per 10000 miles (English
units) and corresponds to gasoline vehicles between 1 year and an age which has
been entered in the gasoline vehicle age classes form. 

For each of the 15 gasoline vehicles categories, the values from 1950 to 2020 of the
emitted pollutants are required, for all brand new vehicles that operate with:

Leaded fuel, without catalyst and without air injection
Unleaded fuel, without catalyst and without air injection (1st generation catalyst
vehicles)
Unleaded fuel, with catalyst, but no air injection
Unleaded fuel, with catalyst and with air injection

To edit the gasoline vehicle deterioration:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Gasoline Vehicle Deterioration (1-age).
4. Select a decade from the drop-down list.
5. Enter the zero kilometer level for each combination.
6. Repeat steps 4 and 5 until all data have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.



Pollutants 43

© 2012 TechnoLogismik i

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.2.4 Gasoline vehicle deterioration (age-25)

The gasoline vehicle deterioration quantifies the effect of vehicle aging of the emission
control mechanism to the pollutant emission. The deterioration is entered in grams per
km per 10000 km (metric system) or in grams per mile per 10000 miles (English
units) and corresponds to gasoline vehicles between an age which has been entered in
the gasoline vehicle age classes form and 25 years. 

For each of the 15 gasoline vehicles categories, the values from 1950 to 2020 of the
emitted pollutants are required, for all brand new vehicles that operate with:

Leaded fuel, without catalyst and without air injection
Unleaded fuel, without catalyst and without air injection (1st generation catalyst
vehicles)
Unleaded fuel, with catalyst, but no air injection
Unleaded fuel, with catalyst and with air injection

To edit the gasoline vehicle deterioration:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Gasoline Vehicle Deterioration (age-25).
4. Select a decade from the drop-down list.
5. Enter the zero kilometer level for each combination.
6. Repeat steps 4 and 5 until all data have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.2.5 Diesel vehicle age classes

For the 13 diesel vehicles categories, enter the ages (from 1 to 25) that will be used to
separate the diesel vehicle deterioration. For example, if for the LDDV category the
value 10 is entered, then the deterioration will be taken into account for vehicles
between 1 to 10 years old and 10 to 25 years old. If the age is set equal to 1 or 25,
one of the two deterioration categories will be obsolete.

To edit the diesel vehicle age classes:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Diesel Vehicle Age Classes.
4. The ages are directly entered in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.2.6 Diesel vehicle sulfur

For each year between 1950 until 2020, the sulfur levels are entered for diesel
vehicles. The default value for diesel vehicle sulfur is 500 ppm (parts per million).
Through this form, the user can change the default value. The only reason a user
would need to change the sulfur level input is if they are entering alternate total
exhaust particulate emission factors which are not based on tests using 500 ppm
diesel fuel sulfur.

To edit the diesel vehicle sulfur:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Diesel Vehicle Sulfur .
4. The ages are directly entered in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.2.7 Diesel vehicle zero kilometer level

The zero kilometer level (or mile for English units) of diesel vehicles is the pollutant
emission of brand new diesel vehicles, which are entered in grams per km per 10000
km (metric system) or in grams per mile per 10000 miles (English units).

For each of the 13 diesel vehicles categories, the values from 1950 to 2020 of the
emitted pollutants are required, for all brand new vehicles.

To edit the diesel vehicle zero kilometer level:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Diesel Vehicle Zero Kilometer Level.
4. Select a decade from the drop-down list.
5. Enter the zero kilometer level for each combination.
6. Repeat steps 4 and 5 until all data have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: The data above is required only if the particulates command has been
specified in the project properties.



Mobile Emission52

© 2012 TechnoLogismik i

4.2.8 Diesel vehicle deterioration (1-age)

The diesel vehicle deterioration quantifies the effect of vehicle aging of the emission
control mechanism to the pollutant emission. The deterioration is entered in grams per
km per 10000 km (metric system) or in grams per mile per 10000 miles (English
units) and corresponds to diesel vehicles between 1 year and an age which has been
entered in the gasoline vehicle age classes form. 

For each of the 13 diesel vehicles categories, the values from 1950 to 2020 of the
emitted pollutants are required, for all brand new vehicles.

To edit the diesel vehicle deterioration:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Diesel Vehicle Deterioration (1-age).
4. Select a decade from the drop-down list.
5. Enter the zero kilometer level for each combination.
6. Repeat steps 4 and 5 until all data have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.2.9 Diesel vehicle deterioration (age-25)

The diesel vehicle deterioration quantifies the effect of vehicle aging of the emission
control mechanism to the pollutant emission. The deterioration is entered in grams per
km per 10000 km (metric system) or in grams per mile per 10000 miles (English
units) and corresponds to diesel vehicles between an age which has been entered in
the gasoline vehicle age classes form and 25 years. 

For each of the 13 diesel vehicles categories, the values from 1950 to 2020 of the
emitted pollutants are required, for all brand new vehicles.
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To edit the diesel vehicle deterioration:

1. Select a scenario.
2. From the Pollutants menu choose the Particulate Emission Factors.
3. From the pop-up menu select the Diesel Vehicle Deterioration (age-25).
4. Select a decade from the drop-down list.
5. Enter the zero kilometer level for each combination.
6. Repeat steps 4 and 5 until all data have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:
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1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: The data above is required only if the particulates command has been
specified in the project properties.

4.3 Particle size limit

Allows the user to specify the maximum particulate size cutoff (PSC) that is used by
the model. The emission factors reported for particulate pollutants represent the
estimated grams per kilometer (grams per mile for English units) of particles with
aerodynamic diameters less than or equal to the PSC. The maximum PSC allowed by
the model is 10.0 micrometers and the minimum PSC is 1.0 micrometer.

To edit the particle size limit:

1. Select a scenario.
2. From the Pollutants menu select the Particle Size Limit.
3. Select a value from the drop-down list or enter the PSC directly in the drop list.
4. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: The data above is required only if the particulates command has been
specified in the project properties.
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4.4 Hydrocabron emissions speciation

This command allows the user to specify the particular hydrocarbon species that is
reported in the exhaust emission output.

To specify the hydrocarbon species:

1. Select a run.
2. From the Pollutant menu select Hydrocarbon Emission Speciation.
3. Choose one from the given options.
4. Press Default to restore the default value of the parameter.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If no option is selected then the hydrocarbons will
be reported as volatile organic compounds (VOC).

4.5 No refueling emissions

This command directs the model not to calculate the refueling emissions (also referred
to as Stage II emissions) from gasoline-fueled vehicles. Thus, the composite
hydrocarbon emissions reported to descriptive output will not include refueling
emissions.

To select or exclude refueling emissions:

1. Select a run.
2. From the Pollutants menu select the No Refueling Emissions.
3. Either check or uncheck the option.
4. Press Default to restore the default value of the parameter.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If no option is selected then the program will report
the refueling emissions.

4.6 User defined air toxic pollutants

4.6.1 User defined air toxic pollutants

This command allows the user to enter emission factors or air toxic ratios for additional
air toxic pollutants. The program will read these additional emission factors or ratios
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and calculate composite results for additional pollutants the user may define.

The additional emission factors must be input to the program in units of milligrams
per kilometer (milligrams per mile for English units). The ratios are entered as ratios
of the Air Toxic pollutant in milligrams per kilometer (milligrams per mile for English
units) to the Total VOC, Total TOG or Exhaust PM emission factor (expressed in grams/
kilometer or grams/mile for English units).

To manage user defined air toxic pollutants:

1. Select a scenario.
2. From the Pollutants menu select the User Defined Air Toxic Pollutants.
3. Edit all data relevant to user defined air toxic pollutants.
4. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: If this command is not specified, no additional air toxics are modeled.

4.6.2 Add air toxic pollutant

To add a new air toxic pollutant:

1. Press Add to display the form which is used to add a new air toxic pollutant.
2. Select from the drop-down list or type-in the pollutant number from 50 to 99.
3. Enter the pollutant name. Any name can be specified for a pollutant as long as it
is used consistently in all of the input records.
4. Select whether the pollutant is associated with exhaust or evaporative processes.
All evaporative exhaust air toxic emission factors must be ratio types. No basic
emission factor (BEF) types will be allowed for evaporative air toxic emission factors.
Note, a single evaporative ratio will be applied to all evaporative emission types (hot
soak, diurnal, resting loss, etc). There can be up to 50 user defined air toxic
pollutants.
5. Select the vehicle type associated with the pollutant. You can select any of the 28
vehicle categories.
6. Select the first model year for a particular air toxic emission factor from the drop-
down list. It can range from 1951 through 2025. The model year range established by
first and last model years for a pollutant must include the complete 25 year range of
model years needed to compute emission factors for a given calendar year. For
example, if the user desires to model calendar year 2000, then first model year on at
least one record must be no later than 1975. The exception is that model years prior
to 1951 will use 1951 entries.
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7. Select the last model year for a particular air toxic emission factor from the drop-
down list. This is the last model year of coverage for a particular air toxic emission
factor. It can range from 1951 through 2050. The last model year on at least one
record for the pollutant must be equal to or later than the calendar year which is being
modeled. For example, if calendar year 2000 is being modeled, then last model year
can be 2000 or later.
8. Select the emission factor fraction from the drop-down list. This is a categorized
field that accepts a test entry of RATIOVOC, RATIOTOG, RATIOPM or BEF. RATIOVOC
indicates an emission factor that is a fraction of the VOC emissions. RATIOTOG
indicates an emission factor that is a fraction of the TOG emissions. RATIOPM indicates
an emission factor that is a fraction of the total exhaust PM. If the user enters
RATIOPM, then the particulates command must be specified so that the program will
calculate total exhaust particulate emission factors to use in calculating the Air Toxic
emission factor. An error message will result if there is a conflict. If the user enters
RATIOPM, then the particulates command must be specified so that the program will
calculate total exhaust particulate emission factors to use in calculating the Air Toxic
emission factor. An error message will result if there is a conflict. Note that the user-
specified particle size cutoff value is used to calculate the PM emissions to which the
HAP emissions are ratioed. If the RATIOVOC, RATIOTOG or RATIO PM commands are
specified, then the user shall enter the appropriate fraction in the Zero Kilometer
(Mile) Level (ZKL/ZML) field. If the user enters BEF, then the program shall read a
zero kilometer (mile) emission level and the deterioration rate for the pollutant. 
9. Enter the zero kilometer (or mile for English units) emission level. This is a
numeric field where either the air toxic emission fraction
is specified or the zero kilometer (mile) emission level in units of milligrams per
kilometer (mile) is specified.
10. If the basic emission factors (BEF) has been selected in step 8, then enter the
deterioration rate. This is a numeric field where deterioration rate emission level in
units of milligrams per kilometer (mile) per 10,000 kilometers (miles) is specified. It
is blank if the RATIO is specified in step 8.
11. Select Ok to add the new air toxic pollutant at the end of the list and close the
dialog box. Select Cancel to close the dialog box without saving any changes.

4.6.3 Delete air toxic pollutant

The selected from the list air toxic pollutant is removed.

To delete an existing air toxic pollutant:

1. Select from the list of air toxic pollutants the record which is about to be removed.
2. When the user clicks Remove it is asked whether he confirms the removal of the
selected record, if the confirmation option has been activated in the general
preferences.
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3. The selected record is removed.

4.6.4 Change air toxic pollutant

The user may change the properties of an existing air toxic pollutant.

To change the properties of an existing air toxic pollutant:

1. Select from the list of air toxic pollutants the record which is about to be changed.
2. Click on Change to open the form used to commit changes to an existing record.
3. Make the changes.
4. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

4.6.5 Clear all records

All existing records are removed from the list.

To remove all existing records:

1. Click Clear. The user will be asked to confirm the global removal.
2. Select Yes to remove all records.

4.6.6 Import from file

Additional air toxic pollutant records may be imported from an external file. The
existing records will be kept and the new records will be appended to the existing
ones.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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4.6.7 Export to file

The current recordset of additional air toxic pollutants is exported to an external file.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

4.7 Fuel economy data

This command allows the user to enter fuel economy performance data by vehicle 
class and model year (between 1952 and 2050) to replace the default values built into
the model. This capability could be used to estimate the effect of the introduction into
the fleet of more fuel efficient vehicles. Fuel economy values have a small effect on
evaporative refueling losses and sulfate particulate emissions in addition to strongly
affecting CO2 emissions.
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To enter vehicle fuel economy data:

1. Select a scenario.
2. From the Pollutant menu select Fuel Economy Data.
3. Select a decade from the drop-down list.
4. Type in the desired values in the table in kilometer per liter (metric system) or
miles per gallon (English units).
5. Repeat steps 3 and 4 until all values have been entered.
6. Optionally, click on Clear to delete all entered values.
7. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: If this command is not specified then the default fuel economy values built
into the model are used.
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5 Environment

5.1 Environment menu

This menu is used to enter or edit all data relevant to the external (environmental)
conditions of the study area. In particular, the following options are offered via this
menu:

Calendar year
Evaluation month
Ambient daily temperature
Altitude
Absolute humidity
Cloud cover
Peak sun
Sunrise and sunset
Relative humidity
Barometric pressure

5.2 Calendar year

This command identifies the calendar year for which emission factors are to be
calculated, often referred to as calendar year of evaluation. The program can model
emission factors for the calendar years 1952 to 2050, inclusive. 

To select a calendar year:

1. Select a scenario.
2. From the Environment menu select Calendar Year.
3. Select a calendar year from the drop-down menu from 1952 to 2050.
4. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: Users must supply this information.

5.3 Evaluation month

This command provides the option of calculating emission factors for January 1 or July
1 of the calendar year of evaluation. The model allows the choice of January 1st or July
1st. The specified month will affect emission calculations in two ways:

by changing the composition of the fleet (July 1 emission factors will reflect an
additional six months of fleet turnover, or replacement of older vehicles by new
vehicles), and
by changing how the effects of reformulated gasoline (RFG) are modeled. If the user
selects January 1st, the model will apply winter season RFG rules. If the user selects
July 1st, the model will apply summer season RFG rules.
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The value of month is independent of temperature, fuel volatility, and other inputs,
which users still must select in a way that is consistent with the evaluation month. It
is possible to estimate the emission results for any evaluation date (month) by
mathematical interpolation between two results. For example, using the same input
parameters, two runs for January and July can be used to estimate May 1st emissions,
by weighting the January results by 0.333 and weighting the July results by 0.667.
Care should be taken to assure that both the two runs use the appropriate parameters
(i.e., temperature, fuels, etc.) and the programs in use that would apply on the target
evaluation date. 

To select the evaluation month:

1. Select a scenario.
2. From the Environment menu select the Evaluation Month.
3. Select the evaluation month from the drop-down list.
4. Click the Default button to select the default value of the parameter.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If no evaluation month is set or the N/A value is
selected from the drop-down list, then January 1st is automatically set as the
evaluation month.

5.4 Ambient daily temperature

Enter either the maximum and minimum daily temperature or the ambient
temperature for each hour of the day.

To enter the minimum and maximum daily temperature:

1. Select a scenario or a run.
2. From the Environment menu select Ambient Daily Temperature.
3. Activate the Use minimum and maximum daily temperatures option.
4. Enter the minimum daily temperature which may vary from -18 to +38 degrees
Celsius (0 to 100 degrees Fahrenheit).
5. Enter the maximum daily temperature which may vary from -12 to +49 degrees
Celsius (10 to 120 degrees Fahrenheit).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To enter the ambient temperature for each hour of the day:

1. Select a scenario or a run.
2. From the Environment menu select Ambient Daily Temperature.
3. Activate the Use ambient temperature per hour option.
4. Type-in the hourly temperatures in the table. The temperatures should range from -
18 to +49 degrees Celsius (0 to 120 degrees Fahrenheit).
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is mandatory. The user must supply either the minimum and
maximum daily temperatures or the ambient temperature for each hour of the day.

5.5 Altitude

This command indicates whether the model will calculate emissions for a high or a
low-altitude region. It can calculate separate emission rates for high- and low-altitude
regions. Low-altitude emission factors are based on conditions representative of
approximately 150 meters (500 feet) above mean sea level. High-altitude factors are
based on conditions representative of approximately 1700 meters (5,500 feet) above
mean sea level. When high-altitude region emission factors are requested, the model
also includes vehicles that were built to meet specific high-altitude emission
standards. 

To select an altitude:

1. Select a scenario.
2. From the Environment menu select Altitude.
3. Select the area type.
4. Click the Default button to select the default value of the parameter.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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NOTE: This command is optional. If no altitude is set or the N/A value is selected
from the drop-down list, then low altitude is automatically set as the evaluation
month.

5.6 Absolute humidity

This command is used to specify a daily average for humidity. The humidity value
affects Nox emissions. The model also converts the specified absolute humidity to 
relative humidity, which in turn is used to calculate a heat index. The heat index
affects the portion of the vehicle fleet that the model determines is using air
conditioning, thereby affecting CO, HC, and HC-related air toxics emissions.

This command requires one value in the data portion of the record that represents the
absolute humidity in grams of water per kilogram of dry air (or grains of water per
pound of dry air for English units). The value must be between 2.86 and 75.4 gr/kg or
20.0 and 528.0 grains/pound.

To enter the absolute humidity:

1. Select a scenario or a run.
2. From the Environment menu select Absolute Humidity.
3. Enter the desired value between 2.86 and 75.4 gr/kg or 20 and 528 grains/pound.
4. Optionally, press the Default button to enter the default value of the parameter
which is equal to 10.71 gr/kg or 75 grains/pound.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If no absolute humidity is entered, then the default
value of 10.71 gr/kg or 75 grains/pound will be used.

WARNING: The model does not check that the absolute humidity value and the
temperature range yield a relative humidity which does not exceed 100 percent.

5.7 Cloud cover

This command allows users to specify an average percent cloud cover for a given day.
This feature affects only the air conditioning correction. This value must be between
0% and 100%, inclusive.

To enter the cloud cover:

1. Select a scenario or a run.
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2. From the Environment menu select Cloud Cover.
3. Enter the desired value which can range from 0 to 100%.
4. Optionally, press the Default button to enter the default value of the parameter
which is equal to 0% (no cloud cover).
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If no cloud cover is entered, then the default value
of 0% will be used.

5.8 Peak sun

This command allows users to specify the midday hours when the sun is at peak
intensity. This feature only affects the air-conditioning correction. The peak sun
command requires two integers in the data portion of the record. Peak sun is applied
as a range by virtue of the fact that the intensity of solar load is roughly within 5
percent of maximum solar load (noon) for several hours throughout mid-day,
depending on the season. 

The default times span the range of this condition for early summer conditions; in
considering changes to the
default values, the user should evaluate data on direct solar radiation, commonly
available through NOAA’s Surface Radiation (SURFRAD) monitoring system. It is
important to note that air conditioning adjustments are also applied at times outside
the peak sun range, but
at a lesser magnitude per the reduced solar load.

To enter the peak sun:

1. Select a scenario or a run.
2. From the Environment menu select Peak Sun.
3. Select the peak sun start time from the drop-down list between 9 AM to 12 AM.
4. Select the peak sun end time from the drop-down list between 1 PM to 5 PM.
5. Optionally, press the Default button to enter the default values of the parameters
which is equal to 10 AM and 4PM for the peak sun start and end time respectively.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If no peak sun start and end times are entered or
the N/A values are selected, then the default values of 10 AM and 4 PM will be used.
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5.9 Sunrise and sunset

This command allows users to specify the time of sunrise and sunset. This feature
affects only the air-conditioning correction. The sunrise must be between 5 a.m. and 9
a.m. The sunset must be between 5 p.m. and 9 p.m. Although most of the units for
time of day (in the model) count from 6 a.m., both of the sunrise and sunset values
use the traditional clock time, counting from midnight.

To enter the sunrise and sunset values:

1. Select a scenario or a run.
2. From the Environment menu select Sunrise And Sunset.
3. Select the sunrise time from the drop-down list between 5 AM to 9 AM.
4. Select the sunset time from the drop-down list between 5 PM to 9 PM.
5. Optionally, press the Default button to enter the default values of the parameters
which is equal to 6 AM and 9 PM for the sunrise and sunset respectively.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If no sunrise and sunset times are entered or the
N/A values are selected, then the default values of 6 AM and 9 PM will be used.

5.10 Relative humidity

This command is used to specify hourly relative humidity values and allows the user to
relate these relative humidity values directly to the hourly temperature values (see
also the barometric pressure command). 

The humidity input directly affects Nox emissions through a humidity correction factor
for Nox emissions. The humidity value also affects the model's air conditioning (A/C)
correction factors for HC, CO, and Nox emissions. This is done in the model by
calculating a heat index with the relative humidity inputs. The heat index is used in
conjunction with vehicle A/C usage statistics to calculate the air conditioning
correction factors.

The relative humidity command directs the model to use the 24 values of relative
humidity entered by the user. The program will perform hour-specific calculations with
the specified hourly values rather than use the single default value of absolute
humidity. In particular, the hourly relative humidity values together with hourly
temperature values and barometric pressure are used to calculate hourly absolute
humidity values. Subsequently, hourly humidity effects on Nox emissions can be
determined. 

Also, the hourly relative humidity values are used directly to determine hourly heat
indices which are used to determine the air conditioning effects on HC, CO, and Nox
emissions.



Mobile Emission70

© 2012 TechnoLogismik i

To enter the relative humidity:

1. Select a scenario.
2. From the Environment menu select Relative Humidity.
3. Enter the desired values directly in the table.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
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4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This command is optional. If no data are entered, then the absolute humidity
is used instead of the relative humidity. If the relative humidity is used, then the 
barometric pressure is used as well.

5.11 Barometric pressure

This command is used to specify a daily average barometric pressure. When the 
relative humidity command is used, the user supplied relative humidityvalues are
converted to absolute humidity. This conversion requires values of temperature and
barometric pressure. The barometric pressure command allows the user to change the
default value of barometric pressure used in the humidity conversion.

This command requires one value that represents the barometric pressure in
millimeters (inches for English units) of mercury. The value must be between 330.2
and 838.2 mm mercury or 13.0 and 33.0 inches of mercury.

To enter the barometric pressure:

1. Select a scenario or a run.
2. From the Environment menu select Barometric Pressure.
3. Enter the desired value between 330.2 and 838.2 mm Hg or 13 and 33 in Hg.
4. Optionally, press the Default button to enter the default value of the parameter
which is equal to 759.95 mm Hg or 29.92 in Hg.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This command is optional. If the relative humidity is not used, then the
barometric pressure is not used either. If the relative humidity is used and no
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barometric pressure is specified, its default value will be used which is equal to 
759.95 mm Hg or 29.92 in Hg.
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6 Fleet

6.1 Fleet menu

Fleet characteristic commands allow users to describe a given fleet by vehicle age,
power source and activity level. Several of these commands involve vehicle age. In
particular, the following options are offered via this menu:

Distribution of vehicle registrations
Diesel fractions
Annual kilometers accumulation rates
Vehicle kilometers traveled
o Fractions

o By facility

o By hour

o By speed

o By average speed

Natural gas vehicles
o Fractions

o Alternate emission factors

o Add alternate emission factor

o Delete alternate emission factor

o Change alternate emission factor

o Clear all records

o Import from file

o Export to file

Starts per day
Distribution of vehicle starts during the day
Soak distribution
Hot soak activity
Diurn soak activity
Weekday trip length distribution
Weekend trip length distribution
Select weekday or weekend

6.2 Distribution of vehicle registrations

This command allows users to supply vehicle registration distributions by vehicle age
for any of the 16 composite (combined gas and diesel) vehicle types. By default, the
model applies a registration distribution for each of the 16 composite vehicle types
based on U.S. vehicle fleet data. 

Program users may specify vehicle registration data for each of 25 vehicle ages for one
or more of the 16 composite vehicle types. Values are entered with four decimal digits.
The sum of the 25 values should equal 1.0. If they do not, the program automatically
normalizes all values to 1.0.

To enter the distribution of vehicle registrations:

1. Select a run.
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2. From the Fleet menu select Distribution of Vehicle Registrations.
3. Type in the desired values directly in the table. A value equal to 0 means that there
are no vehicles in the category that corresponds to the column where this value
belongs and for the age that corresponds to the row where this value belongs.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:
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1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional. If not supplied, technical report M6.FLT.007, contains the
default age distributions used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.3 Diesel fractions

This command permits users to supply locality-specific diesel fractions for 14 of the 16
composite vehicle categories by vehicle age.

1971 and earlier model years are assumed to have the same diesel fraction as the
1972 model year.
1997 and later model years are assumed to have the same diesel fraction as the
1996 model year.

Diesel fractions allow the program to perform separate calculations for gas and diesel
subcategories, which have distinctly different emission rates. Urban/transit buses are
assumed to be all diesel-fueled, and motorcycles are assumed to be all gasoline-
fueled, so these two categories do not require a diesel fraction. That leaves 14
composite vehicle categories for which users can specify a diesel fraction. 

The diesel fraction represents the percent of diesels in a composite vehicle category for
any vehicle age. The model year that the model applies to each value depends on the
calendar year of evaluation. This means that the user must provide separate input for
each calendar year to be modeled. The program assumes that all non-diesel vehicle
sales are gasoline-fueled vehicles.

If the user selects this command, diesel fractions must be provided by age of vehicle
and for each of the 14 composite vehicle types. With 14 vehicle categories and 25
vehicle ages, the user needs to enter 350 separate diesel fractions. The user must
provide separate input for each scenario to run multiple calendar years.
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For each one of the 25 years, a number between 0 and 1 is entered. This number
dictates the percentage of vehicles of a particular category that use diesel. For
example, if for a particular year the number 0.2 in entered for the LDV category, then
80% of the vehicles operate on gasoline, while the remaining 20% operate on diesel.
The fractions are entered using four decimal digits accuracy.

To enter the diesel fractions:

1. Select a run or a scenario.
2. From the Fleet menu select Diesel Fractions.
3. Type in the desired values directly in the table. A value equal to 0 means that there
are no diesel vehicles in the category that corresponds to the column where this value
belongs and for the age that corresponds to the row where this value belongs.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional. If not supplied, technical report M6.FLT.007, contains the
default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.4 Annual kilometers accumulation rates

This command allows users to supply the annual kilometers (mileage) accumulation
rates by vehicle age for any or all of the 28 individual vehicle types. The kilometers
(mileage) accumulation rate represents the total annual travel accumulated per
vehicle of a given age and individual vehicle category. The user does not need to enter
kilometers (mileage) for all categories. 
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The program will apply default values for any vehicle type that the user does not
specify. The value entered represents the kilometers (miles for English units) traveled
by a vehicle type of a specified age divided by 100,000. For example, if the user
enters 0.15 for LDGV vehicles that are 5 years old, then this means that vehicles
belonging to the LDGV category and are 5 years old, traveled 0.15x100000=15000 km
(or miles for English units).

To enter the annual kilometers accumulation rates:

1. Select a run.
2. From the Fleet menu select Annual Kilometers Accumulation Rates.
3. Select a group of vehicles from the drop-down list.
4. Type in the desired values directly in the table. A value not entered is replaced by
the default value (see note at the end of the paragraph).
5. Repeat steps 3 and 4 until all values have been entered.
6. Optionally, click on Clear to delete all data that are present in the table.
7. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional. If not supplied, technical report M6.FLT.007, contains the
default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.5 Vehicle kilometers traveled

6.5.1 Fractions

This command and the three that follow, along with the mileage accumulation rate
option, allow users to supply vehicle travel data specific to the geographical location
they wish to model. The command allows users to allocate VMT (Vehicle Kilometers or
Miles Traveled) to specific vehicle types. The VMT fractions are used to weight together
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the emissions of the various vehicle types into the average emissions for groupings of
vehicle classes, such as the HDGV and All Vehicles categories in the descriptive
output.

The VMT FRACTIONS command should be used to properly model any situation in
which the local mix of the 16 combined vehicle types differs from the national (U.S.)
average.

By default, the program calculates a default VMT mileage distribution from national
United States average data and/or user-supplied information, specifically:

1. The calendar year of evaluation.
2. Default vehicle population data for the 16 composite vehicle classes.
3. Default or user-supplied vehicle registration by age distribution data.
4. Default or user-supplied diesel fractions.
5. Default or user-supplied mileage accumulation data.

The default data for items 2 through 5 are described in technical report, M6.FLT.007
(see bottom note). Note that the model users are not allowed to change data item 2
as such; this command is provided instead. Note also that the total vehicle population,
per se, is not significant in the model because all emission results are expressed on a
per-vehicle-mile basis. Therefore, only the fraction of vehicles of
each age and class actually affects the results.

The VMT mix specifies the fraction of total highway VMT that is accumulated by each
of the 16 composite vehicle types. Each VMT mix supplied as input must consist of a
set of 16 fractional values, representing the fraction of total highway VMT accumulated
by each of 16 combined vehicle types. All values must be between 0 and 1, and the
16 values must add up to 1.0. The program automatically normalizes the values so
that they add up to 1. 

To enter the fractions of vehicle kilometers traveled:

1. Select a run or a scenario.
2. From the Fleet menu select Vehicle Kilometers Traveled menu.
3. From the new pop-up menu select Fractions.
4. Enter the desired values directly in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.



Fleet 83

© 2012 TechnoLogismik i

NOTE: This data is used along with the annual kilometers accumulation rates to
calculate the distribution of the vehicles categories per traveled kilometers.

NOTE: This data is optional. If not supplied, technical report M6.FLT.007, contains the
default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.5.2 By facility

This command allows users to allocate VMT to various roadway or facility types by
vehicle class. By default, the program uses national (U.S.) estimates of the
distribution of VMT by facility type. The default values are the same for every vehicle
type. The technical
report, M6.SPD.003, provides an explanation of the methodology used to generate
these default values (see bottom note).

The VMT by facility command allows users to enter VMT distributions for each of the 28
vehicle classes across four roadway types for each of the 24 hours of the day. The user
must enter the 96 VMT fractions representing the fraction of travel on each roadway
type at each hour of the day for that vehicle class. The user is permitted to enter VMT
fractions (in blocks of 96 VMT fractions) for any
individual vehicle class, or for any number of vehicle classes up to 28 classes. If the
user chooses to enter VMT fractions for less than all of the 28 vehicle classes, the
program will use default VMT fractions for the vehicle classes unspecified by the user.

For a given vehicle class, the VMT fractions must be entered as 24 values for each
successive hour of the day starting with 6 a.m. There must be four sets of 24 values
corresponding to the four facility types, and the four sets must be entered in the
following order: freeway, arterial, local, and ramp.

The distributions for each hour must add up to 1. If they do not, the program will
automatically normalize them. The program's default for this input is the same for
every vehicle type. For example, in default runs, heavy-duty trucks have the same
VMT distribution by
roadway as passenger cars. If VMT by roadway distribution data is available by vehicle
class, this command allows the user to supply the appropriate VMT fractions.
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Also, the name used for this command and the two that follow could lead to a
misinterpretation of their function. This command requires the user to provide
fractional values for the four roadway types at each of the 24 hours of the day for a
given vehicle class. Because the total VMT within each hour varies across the day, the
input fractions will not add up to the fraction of daily VMT on each roadway type.

The data in this command and the VMT BY HOUR command can be multiplied (outside
of the program) to obtain the distribution of VMT during the 24 hours of the day and
for each facility type.

To enter the vehicle kilometers traveled by facility:

1. Select a run or a scenario.
2. From the Fleet menu select Vehicle Kilometers Traveled menu.
3. From the new pop-up menu select By Facility.
4. Select a vehicle category from the drop-down list.
5. Enter the desired values directly in the table.
6. Repeat steps 4 and 5 until all values have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional. If not supplied, technical report M6.SPD.003, contains
the default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.5.3 By hour

This command allows users to allocate the fraction of VMT that occurs at each hour of
the day. By default the program uses national data (U.S.) for the default distribution
of VMT by hour, as described in technical report, M6.SPD.003 (see bottom note).

This command permits the user to allocate total VMT among the 24 hours of each day.
The values for the command are independent of facility type, that is, the VMT fraction
covers all facility types. The 24 values must add up to 1. If they do not, the program
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will automatically normalize them. Values are entered with four decimal digits.

To enter the vehicle kilometers traveled by hour:

1. Select a run or a scenario.
2. From the Fleet menu select Vehicle Kilometers Traveled menu.
3. From the new pop-up menu select By Hour.
4. Enter the desired values directly in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:
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1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional. If not supplied, technical report M6.SPD.003, contains
the default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.5.4 By speed

This command allows users to allocate VMT by average speed on freeways and arterial
roads. By default the program uses national fleet data (U.S.) for the default
distribution of VMT by average speed for freeways and arterial roadways, as described
in technical report, M6.SPD.003 (see bottom note).

The SPEED VMT command name permits the user to enter the VMT distribution over
preselected average speed ranges. The program calculates these distributions for each
of the 24 hours of the day and for freeways and arterials (producing 48 separate
distributions, each containing 14 fractions). The data in this array are not sufficient to
estimate either hourly VMT distribution or the VMT distributions by facility type.

The 14 average speed fractions (0.0000 through 1.0000) must add up to 1. The first
of the 14 preset speeds is 'idle,' and the other 13 average speeds range from 4 to
100.6 km/m in 8 km/h increments or 5 mph to 65 mph in 5 mph increments. This
pattern must be repeated for each combination of roadway type (arterial and freeway)
and time of day. Distributions must be entered for all facility types and hours.

To enter the vehicle kilometers traveled by speed:

1. Select a run or a scenario.
2. From the Fleet menu select Vehicle Kilometers Traveled menu.
3. From the new pop-up menu select By Speed.
4. Select a category from the drop-down list.
5. Enter the desired values directly in the table.
6. Repeat steps 4 and 5 until all values have been entered.
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7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
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3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional. If not supplied, technical report M6.SPD.003, contains
the default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.5.5 By average speed

This command allows users to designate a single average speed to use for all freeways
and/or arterial/collectors for the entire day. By default the program uses national fleet
data (U.S.) for the default distribution of VMT by average speed for freeways and
arterial roadways, as described in technical report, M6.SPD.003 (see bottom note), or
a user supplied VMT by average speed distribution provided using the VMT by speed
command.

The VMT by speed command permits the user to replace the default values with a VMT
distribution over fourteen average speed bins. However, in some modeling situations
the user may wish to enter a single value instead of a distribution. For example, the
user may need to model roadway links separately, or may not have the VMT
distribution information. In these cases, the program can be used to
calculate results for a single specified average speed. The By average speed command
automatically replaces the VMT by speed and VMT by facility data files with the
appropriate average speed and facility type information for a single average speed.
(All of the functions of the By average speed command can be duplicated using the 
VMT by speed and VMT by facility commands, if desired. 

The By average speed command includes up to six data elements. The first two of the
data elements are required. The elements must be entered on the command line. The
data elements are:

Average speed
Roadway scenario
Distribution of VMT by facility (4 values)

Each element is described in detail below.
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Average speed value (4.1 to 104.6 km/h or 2.5 to 65 mph for English units).

As with all average speed inputs to the model, the allowed user supplied average
speed value may range from 4.1 to 104.6 km/h 2.5 through 65 miles per hour for
English units. Any integer or decimal value in that range may be used.

Indication of the roadway scenario the user wishes to model

Non-Ram p All VMT occurs on freeways, not including freeway ramps,
Freeway All VMT occurs on freeways, including freeway ramps
Arterial All VMT occurs on arterial/collector roadways, or
Areaw ide VMT occurs on all roadway types as determined by the VMT by facility
command or the using national average (U.S.) defaults.

The roadway scenario indicates the type of driving that the user intends for the
average speed input to model. (Note: the average speed used for local roadways and
freeway ramps cannot be changed by the user.)

Non-Ram p
The “Non-Ramp” roadway scenario assigns all VMT to the freeway roadway type, with
the VMT automatically distributed among two average speed bins which average to the
single average speed indicated by the user. No freeway ramp driving is included in the
estimate. The VMT from freeway ramps and all the other roadway types is set to zero
for all hours of the day.

Freeway
The “Freeway” roadway scenario assigns all VMT to either the freeway or the freeway
ramp roadway types. If the user does not specify the distribution of VMT by facility,
the national average fraction of freeway ramp activity (8% freeway ramp and 92%
non-ramp freeway) is used. Freeway ramps have a constant speed of 55.7 km/h or
34.6 mph, which cannot be changed by the user. A single average speed for the non-
ramp freeway VMT is calculated using the fixed freeway ramp average speed and the
freeway ramp VMT fraction such that the combined ramp and non-ramp average speed
matches the average speed value entered by the user. All of the non-ramp freeway
VMT is then automatically distributed among two average speed bins which average to
the calculated average non-ramp freeway speed.

Arterial
The “Arterial” roadway scenario assigns all VMT to the arterial/collector roadway type
with a single average speed as indicated by the user. The VMT from the other roadway
types is set to zero for all hours of the day.

Areaw ide
When the user indicated the 'Areawide' roadway scenario, the program selects a single
average speed for the freeway roadway type and a single average speed for the
arterial/collector roadway type such that the combined average speed for all roadway
types (including local roadways and freeway ramps) will match the average speed
value entered by the user. If the user does not specify the distribution of VMT by
facility (described below), the national (U.S.) default distribution (34.2%
freeway,49.8% arterial/collector, 13% local, 3% freeway ramp) is used. This same
distribution of VMT by facility is used for all hours of the day for all vehicle types.
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Since the freeway ramp and local roadway speeds are fixed, the program may not be
able to model the average speed indicated by the user if the average speed desired is
too high or too low. In these cases a calculated maximum speed or a calculated
minimum speed is substituted for the user supplied average speed and a warning,
indicating the actual average speed used, is written to the descriptive output.

Distribution of VMT by facility to be used (optional, four values)

Fraction of VMT which occurs on freeways (non-ramp),
Fraction of VMT which occurs on arterial/collector roadways,
Fraction of VMT which occurs on local roadways, and
Fraction of VMT which occurs on freeway ramps.

The effect of entering an areawide average speed or an average speed on freeways,
including ramps, will depend on the distribution of VMT by facility (roadway type). If
the user does not specify the distribution of VMT by facility, the national average
distribution (U.S.) is used to calculate the appropriate VMT by facility:

34.2% (freeway)
49.8% (arterial/collector)
13.0% (local)
3.0% (freeway ramp)

The user may override these values by entering four new values in the order indicated
above. The sum of the four values must equal 1.0 or 100(%). All four values must be
entered. The entry of any distribution of VMT by facility values, either using the VMT
by facility command or as part of the By average speed command, has no effect when
the user selects either a “freeway” or an “arterial” roadway scenario, since in these
cases, all VMT is assigned to either the freeway roadway type or the arterial/collector
roadway type, respectively.

Be aware that using the By average speed command will override the default and user
supplied distribution of VMT by facility values used to calculate the results. The same
distribution of VMT by facility values is used for all hours of the day for all vehicle
classes. Similarly, the same average speed is used for every hour of the day. Since
other factors, such as temperature, vary across the
day, the composite results shown in the descriptive output is the VMT weighted daily
average emission rate at that average speed.

Since the effects of speed on emissions is not linear, using a single average speed will
not produce the same emission result as the weighted results of a number of separate
model runs with different average speeds. If the composite emissions of multiple
roadways with different speeds are to be calculated, a model run using a distribution
of average speeds should be used. However, it is appropriate to use the By average
speed command to generate a single average speed result to represent similar
roadways with similar average speeds (i.e., a lookup table).

The By average speed command does not bypass the model's average speed bins.
Instead, the model calculates an appropriate distribution of average speeds across two
average speed bins to match the user-specified average speed. 

To enter the vehicle kilometers traveled by average speed:
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1. Select a scenario.
2. From the Fleet menu select Vehicle Kilometers Traveled menu.
3. From the new pop-up menu select By Average Speed.
4. Select a scenario:

None - disables this function.
Freeway (no ramps)
Freeway (with ramps) - enter the fractions which occur on freeways and ramps
Arterial 
Areawide - enter the fractions which occur on all four categories

5. Enter the average speed.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not supplied, technical report M6.SPD.003, contains
the default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.6 Natural gas vehicles

6.6.1 Fractions

This command is used to indicate the percent of vehicles in the fleet certified to
operate on (not retrofitted for) either compressed or liquefied natural gas. By default,
the fraction of NGV vehicles in the fleet is zero.

This command allows the user to specify the percent of NGVs in each of the 28
individual vehicle classes beginning with the 1994 model year. If the user enters
100% NGV, the model will report the basic NGV emission rate. Any other percentage
will specify a fleet that is part NGV, with gasoline and diesel vehicles comprising the
remaining part of the fleet.

The NGV FRACTION command also affects evaporative emissions, which the model
assumes are zero for NGVs. Thus, if the user enters 5 percent for the NGV penetration
of a particular gasoline vehicle class, the model will assume that 5 percent of that
class will have zero evaporative emissions.

The values can range from 0.0000 to 100.0000. The percentage of NGVs in the fleet is
very small. The program provides this option for special cases in which it is necessary
to model the effects of NGVs on a small percentage of the fleet, or to generate the
basic NGV emission factors by entering 100 percent penetration.

To enter the fractions of natural gas vehicles in the fleet:

1. Select a run.
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2. From the Fleet menu select Natural Gas Vehicles.
3. From the new pop-up menu select Fractions.
4. Select a category from the drop-down list.
5. Enter the desired values directly in the table.
6. Repeat steps 4 and 5 until all values have been entered.
7. Optionally, click on Clear to delete all data that are present in the table.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional.

6.6.2 Alternate emission factors

6.6.2.1 Alternate emission factors

This command allows the user to enter alternate NGV emission factors for each of the
28 vehicle types, for HC, CO, and Nox. Where applicable this is done in terms of both
running and start emissions. This label can only be entered if the corresponding NGV
fraction command has also been entered to signal to the model that the user wants to
model the effects of NGV. Note that the PM emissions of NGVs are calculated based on
those of gasoline-fueled vehicles, so no provision, apart from the particulates
command, is made to enter
alternative PM emission factors for NGVs.

The Alternate Emission Factors command allows the user to enter separate NGV
emission factors for each of the 28 vehicle types, for HC, CO, and Nox. Where
applicable this is done in terms of both running and start emissions. It does NOT allow
the user to specify an NGV emission factor for a particular model year. The NGV
emission factor specified by the user for a particular vehicle class and pollutant will be
applied to all 1994 and later model years that are specified to contain natural gas
vehicles. Model year specification is accomplished through the use of the NGV fraction
command.

To manage the alternate emission factors for natural gas vehicles:

1. Select a run.
2. From the Fleet menu select Natural Gas Vehicles.
3. From the new pop-up menu select Alternate Emission Factors.



Fleet 95

© 2012 TechnoLogismik i

4. Manage alternate emission factors data.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional.

6.6.2.2 Add alternate emission factor

To add a new alternate emission factor:

1. Press the Add button on the alternate emission factor management form.
2. Select one of the 28 vehicle categories.
3. Select the pollutant name from the drop-down list.
4. Select the vehicle operation status (running or start) where the pollutant is
emitted.
5. Enter the zero kilometer emission level that corresponds to emitted pollutant
from brand new vehicles.
6. Enter the deterioration per 10000 km, which corresponds to the increase of the
concentration of emitted pollutant per 10000 km.
7. Enter the average emission of high emitters. For the 20 heavy-duty classes this
must be zero.
8. Select Ok to add the new alternate emission factor to the end of the list and close
the dialog box. Select Cancel to close the dialog box without saving any changes.

6.6.2.3 Delete alternate emission factor

The selected from the list alternate emission factor is removed.

To delete an existing alternate emission factor:

1. Select from the list of alternate emission factors the record which is about to be
removed.
2. When the user clicks Remove it is asked whether he confirms the removal of the
selected record, if the confirmation option has been activated in the general
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preferences.
3. The selected record is removed.

6.6.2.4 Change alternate emission factor

The user may change the properties of an existing alternate emission factor.

To change the properties of an existing alternate emission factor:

1. Select from the list of alternate emission factor the record which is about to be
changed.
2. Click on Change to open the form used to commit changes to an existing record.
3. Make the changes.
4. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

6.6.2.5 Clear all records

All existing records are removed from the list.

To remove all existing records:

1. Click Clear. The user will be asked to confirm the global removal.
2. Select Yes to remove all records.

6.6.2.6 Import from file

Additional alternate emission factor records may be imported from an external file. The
existing records will be kept and the new records will be appended to the existing
ones.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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6.6.2.7 Export to file

The current recordset of alternate emission factors is exported to an external file.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

6.7 Starts per day

This command allows users to specify the average number of engine starts (trips) per
vehicle per day for specific vehicle classes and ages for weekend days and/or
weekdays. By default, the program assigns each of the 28 individual vehicle classes at
each of 25 ages a
separate default for number of engine starts per day. 

The defaults differ for weekdays and weekends. Light duty passenger vehicles use
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7.28 starts per day for weekdays and 5.41 starts per day for weekend days. Light
trucks use 8.06 starts per day for weekdays and 5.68 starts per day for weekend days.
Motorcycles use 1.35 starts per day for both weekend and weekdays. Heavy duty
gasoline vehicles and buses use 6.88 starts per day for both weekend and weekdays.
Heavy duty diesel vehicles and buses use 6.65 starts per day for both weekend and
weekdays. The same default value is used for vehicles of all ages within a vehicle
class. Please see the technical report, M6.FLT.003 for more details (see bottom node).

The number of starts per day affects engine exhaust start emission estimates for light
duty gasoline and diesel passenger cars and trucks and motorcycles. It will also affect
the evaporative hot soak losses on all gasoline fueled vehicles, including heavy duty
vehicles and buses, which occur at trip ends. The number of trips per day and trip
ends per day is calculated from the number of starts per day.

Emission estimates for heavy duty diesel fueled vehicles and buses are not affected by
the number of starts per day in MOBILE6. We recommend that users not include
engine starts per day values for heavy duty diesel vehicles and busses in their external
data files. The following table indicates the vehicle classes affected by the number of
engine starts per day and the appropriate vehicle class
number. Only these vehicle classes are affected by use of the Starts Per Day
command.

The user may replace values for as few or as many of these vehicle classes as needed.
No value for the number of engine starts
per day may be less than zero or greater than 100. 

To enter starts per day data:

1. Select a run.
2. From the Fleet menu select Starts Per Day.
3. Select weekdays or weekends from the drop-down list.
4. Enter the desired values directly in the table.
5. Repeat steps 3 and 4 until all values have been entered.
6. Optionally, click on Clear to delete all data that are present in the table.
7. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional. If not supplied, technical report M6.SPD.003, contains
the default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.8 Distribution of vehicle starts during the day

This command allows users to allocate engine starts by hour of the day. By default,
values in technical report, M6.FLT.003 are used (see bottom node). The Distribution of
Vehicle Starts command allows users to change the default values for the hourly
distribution of engine starts (trips) across the day. Users must supply 48 values to
replace the model defaults. 

Each value represents the average fraction of all engine starts that occur in each hour
of a 24 hour day, for both weekdays and weekends. All values must be less than or
equal to 1 and greater than or equal to zero. The sum of all of the 24 values for a day
must equal 1. If they do not, the program will normalize the values to 1 automatically.

To enter the distribution of vehicle starts during the day:

1. Select a run.
2. From the Fleet menu select Distribution Of Vehicle Starts During The Day.
3. Enter the desired values directly in the table.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional. If not supplied, technical report M6.SPD.003, contains
the default values used by the model. This report is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.9 Soak distribution

This command allows users to enter vehicle soak duration distributions that override
the model's defaults. The soak time affects exhaust start emissions. Default
information is provided in technical reports, M6.FLT.003 and M6.FLT.004 (see bottom
node).

A vehicle is considered to be “soaking” if its engine is not running. Soak time is the
length of time between when an engine is turned off and the next time it is started.
The model uses soak time data to determine, for each hour of the day, the percentage
of vehicles that have been soaking for a given amount of time prior to an engine start.
This, in turn, affects start emissions, which depend on the length
of soak time. The same soak time distributions are applied to all vehicle classes and all
vehicle ages.

The Soak Distribution command name requires the user to enter values for each of the
70 soak durations for each of the 24 hours of the day for week and weekend days
(3,360 values). The 70 soak duration values correspond to specific soak length
intervals as defined in the table below. The 70 values for each hour must add up to 1,
if not, the program automatically normalizes the values.

To enter the soak distribution:

1. Select a run.
2. From the Fleet menu select Distribution Of Vehicle Starts During The Day.
3. Select a category from the drop-down list.
4. Enter the desired values directly in the table.
5. Repeat steps 3 and 4 until all values have been entered.
6. Optionally, click on Clear to delete all data that are present in the table.
7. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional. If not supplied, technical reports M6.FLT.003 and M6.
FLT.004, contain the default values used by the model. These reports are located at C:
\Program Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.10 Hot soak activity

This command allows users to specify a hot soak duration distribution for each of 14
daily time periods. Please see technical reports, M6.FLT.003, and M6.FLT.004, for
further information (see bottom note). 

Hot soak emissions occur when fuel vapors escape from a hot vehicle that has just
been turned off. The emissions are highest immediately after the engine is shut down
and decrease over time, reaching a baseline level in about an hour. Hot soak emissions
are truncated if the engine is turned on again before the baseline has been reached
(before an hour has elapsed). The model assumes that hot soak durations range from
1 minute at minimum to a maximum of 60 minutes.

The hot soak time distributions reflect the number of vehicles experiencing a hot soak
of a given duration (1 to 60 minutes) at each hour of the day. The model divides the
day into 14 time periods: one for each hour between 6 a.m. and 7 p.m., plus one for
the hours from 7 p.m. through 5 a.m. the next day. The model computes hot soak
emissions for each minute of each hour, and weights these emissions by the fraction
of vehicles experiencing a hot soak at that time. If this command is used, 840 values
must be entered representing the fraction of vehicles experiencing a hot soak of each
duration (1 to 60 minutes) at each time period of the day (14).

To enter hot soak activity:

1. Select a run.
2. From the Fleet menu select Hot Soak Activity.
3. Type in the desired values directly in the table.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional. If not supplied, technical reports M6.FLT.003 and M6.
FLT.004, contain the default values used by the model. These reports are located at C:
\Program Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.11 Diurn soak activity

This command allows users to specify a diurnal soak time distribution for each of 18
daily time periods. Please see technical report, M6.FLT.006. Diurnal emissions vary
with the length of time a vehicle has been soaking (the length of time it has been
parked). The diurnal ends with the start of a new trip. The program assumes that
diurnal soak times range from one hour at a minimum to a maximum of 72 hours.

Diurnal soak time distributions represent the distribution of the length of time that
vehicles have been soaking during each of the 24 hours for which emissions are to be
calculated. However, the seven hours from 11 PM through 6 AM are treated as having
a common soak time distribution, reducing the number of required distributions that
represent the day from 24 to 18. Since temperatures fall during the night, diurnal
emissions will be calculated to be zero from 12 AM to 6 AM, regardless of the soak
time distribution.

For each hour of the day, the model computes emissions separately for the 72
different soak distributions and weighs them by the fraction of vehicles experiencing a
diurnal of that duration. If the user chooses this command, 1,296 values must be
entered representing the fraction of vehicles experiencing a diurnal of each duration
(72) at each time period of the day (18).

To enter diurn soak activity:

1. Select a run.
2. From the Fleet menu select Diurn Soak Activity.
3. Type in the desired values directly in the table.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.



Fleet 107

© 2012 TechnoLogismik i

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional. If not supplied, technical report M6.FLT.006, contains the
default values used by the model. This reports is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.12 Weekday trip length distribution

This command allows users to specify the fraction of weekday VMT that occurs during
trips of various durations at each hour of the day. The duration of a vehicle trip affects
running loss evaporative emissions, which depend on the amount of time the vehicle
has been running. This command is used to change the default values for the
distributions of VMT by trip duration (in time) for weekdays. The model uses these
distributions to calculate running loss emissions. There is a separate distribution of
VMT by trip duration for each hour
of the day.

If the user chooses to use this command, percentages must be entered for six trip
length ranges and 14 hourly groups, resulting in a total of 84 values. The trip length
ranges are 10 minutes or less; 11 to 20 minutes; 21 to 30 minutes; 31 to 40 minutes;
41 to 50 minutes; 51 or more minutes. The percent of VMT in each of these six trip
length ranges is required for each hour of the day from 6 a.m. to 7 p.m., plus an
average distribution for the 11-hour block from 7 p.m. to 6 a.m. 

To enter the weekday trip length distribution:

1. Select a run or a scenario.
2. From the Fleet menu select Weekday Trip Length Distribution.
3. Type in the desired values directly in the table.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional. If not supplied, technical report M6.FLT.005, contains the
default values used by the model. This reports is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.13 Weekend trip length distribution

This command allows users to specify the fraction of weekend VMT that occurs during
trips of various durations at each hour of the day. The duration of a vehicle trip affects
running loss evaporative emissions, which depend on the amount of time the vehicle
has been running. This command is used to change the default values for the
distributions of VMT by trip duration (in time) for weekend. The model uses these
distributions to calculate running loss emissions. There is a separate distribution of
VMT by trip duration for each hour
of the day.

If the user chooses to use this command, percentages must be entered for six trip
length ranges and 14 hourly groups, resulting in a total of 84 values. The trip length
ranges are 10 minutes or less; 11 to 20 minutes; 21 to 30 minutes; 31 to 40 minutes;
41 to 50 minutes; 51 or more minutes. The percent of VMT in each of these six trip
length ranges is required for each hour of the day from 6 a.m. to 7 p.m., plus an
average distribution for the 11-hour block from 7 p.m. to 6 a.m. 

To enter the weekend trip length distribution:

1. Select a run or a scenario.
2. From the Fleet menu select Weekend Trip Length Distribution.
3. Type in the desired values directly in the table.
4. Optionally, click on Clear to delete all data that are present in the table.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional. If not supplied, technical report M6.FLT.005, contains the
default values used by the model. This reports is located at C:\Program
Files\TechnoLogismiki\TLW2011\Documentation\Supplemental\B35\.

6.14 Select weekday or weekend

The user can select if the weekday or the weekend trip length distribution will be used.

To select weekday or weekend:

1. Select a run.
2. From the Fleet menu choose Select Weekday Or Weekend.
3. Select the appropriate option.
4. Optionally, press the Default button to enter the default value of the parameter
which is equal to 0% (no cloud cover).
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not supplied, the model will use the weekday trip
length distribution.



Chapter

VII
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7 Regulations

7.1 Regulations menu

Regulations and state program commands allow users to model the impact of state-
specific emission control programs such as inspection and maintenance (I/M). In
particular, the following options are offered via this menu:

Stage II refueling
Anti-tampering programs
Inspection / Maintenance programs
o Add program

o Delete program

o Change Program

1990 Clean air act requirements
Heavy duty diesel vehicle emission effects
Tier2 emission standards and fuel requirements
o Disable Tier2

o Tier2 evaporative emissions phase-in

o Tier2 exhaust emissions phase-in

o Alternative Tier2 certification standards

Post 1994 model vehicle standards
2007 heavy duty vehicle emissions requirements

7.2 Stage II refueling

This command allows users to model the impact of a Stage II ('at-the-pump') vapor
recovery system requirement on refueling emissions (also referred to as Stage II
emissions) from gasoline-fueled vehicles. If the user does not use this command, then
program does not calculate impact of a Stage II program.

Stage II systems reduce HC and associated air toxics emissions by reducing the
amount of gasoline vapor that escapes to the atmosphere during refueling and fuel
spillage. The amount of reduction depends on whether the vehicle has an onboard
recovery system and the level of uncontrolled emissions. The uncontrolled emissions
are calculated in MOBILE6 from inputs such as fuel RVP, fuel economy, and various
fuel temperature parameters.

The model applies a 95 percent reduction in refueling emissions from uncontrolled
levels from Onboard Refueling Vapor Recovery (ORVR) equipped vehicles. The effects
of ORVR technology is phased in over several model years. For passenger cars, 40, 80,
and 100 percent of 1998, 1999, and 2000 and newer model year cars respectively will
have ORVR. For light duty trucks up to 6000 pounds gross vehicle weight, 40, 80, and
100 percent of 2001, 2002, and 2003 and newer model year trucks will have ORVR.
For light duty trucks between 6001 and 8500 pounds gross vehicle weight, 40, 80,
and 100 percent of 2004, 2005, and 2006 and newer model year trucks will have
ORVR. Stage II programs will have no additional emission reduction effect on these
vehicles.

To enter Stage II refueling data:
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1. Select a run.
2. From the Regulations menu select Stage II Refueling.
3. Activate Use Stage II Refueling option.
4. Select the calendar year in which the Stage II program began or will begin. The
eligible calendar years are 1989 through 2050, inclusive.
5. Select the number of number of phase-in years of the program. This value can
range from 1 through 9. This value, in combination with the calendar year in which the
Stage II program began, will determine the fraction of vehicle refueling affected by
Stage II controls. The fraction is determined linearly, beginning at zero at the starting
date and with full effect at the final year of the phase-in period.
6. Select the percent efficiency for the LDGVs and LDGTs in the program. This value
can range from 0 through 100.
7. Select the percent efficiency for the HDGVs in the program. This value can range
from 0 through 100.
8. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not entered, then the program will not use stage II
refueling.

7.3 Anti-tampering programs

This command allows users to model the impact of an anti-tampering program (ATP)
and should be used only if the area being modeled has or expects to have such a
program. By default, the program assumes there is no anti-tampering program
present.

Some countries or parts of them have implemented ATPs to reduce the frequency and
emissions impact of emission control system tampering, such as misfueling, removal,
or disablement of catalytic converters. This command allows users to include the
effects of such a program on calculated emission factors.

Selecting this command requires basic information about the anti-tampering program
to be modeled. The required information includes the calendar year that the program
began (start year), the earliest model year that is covered by the program, the latest
model year covered by the program, on/off toggle values that determine if a particular
vehicle class is included in the program, the frequency of inspection, the compliance
rate for the anti-tampering program, and on/off toggle values that determine which
vehicle components will be inspected.

The mere presence of an I/M program is expected to act as a deterrent to tampering.
Therefore, if the 'IM PROGRAM' command is present, the model will reduce the
tampering rates even if there is no anti-tampering program. All 1996 and newer model
year vehicles are assumed to have negligible tampering effects. As a result, there is no
tampering reduction benefit associated with the 1996 and newer vehicles.
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To configure anti-tampering programs:

1. Select a run.
2. From the Regulations menu select Anti-Tampering Programs.
3. Activate the Use anti-tampering program option.
4. Click the Settings tab.

5. Select the calendar year in which the anti-tampering program began or will begin.
The calendar year input can range from 1960 to 2050.
6. Select the earliest model year to be covered by the program. This input is the last
two digits of the model year. The model year range can be from 1960 to 2050.
7. Select the final model year covered by the program. The model year range can be
from 1960 to 2050.
8. Select the inspection frequency: every year or every other year.
9. Select the program compliance rate. This value must be from 0 percent to 100
percent, inclusive.
10. Select the inspections from the list of available inspections. Use the quick keys
Select All, Select None and Invert Selection to select all inspections, select no
inspections and select the unselected inspections and vice versa respectively.
11. Click the Vehicles tab.
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12. Select the vehicle categories that will be included in the anti-tampering program
. Use the quick keys Select All, Select None and Invert Selection to select all
vehicle categories, select no vehicle categories and select the unselected vehicle
categories and vice versa respectively.
13. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not entered, the program assumes there is no anti-
tampering program present.

7.4 Inspection / Maintenance programs

7.4.1 Inspection / Maintenance programs

Many areas of the world have implemented inspection and maintenance (I/M)
programs to further reduce mobile source air pollution. (Note: MOBILE6 does not
model the impact of I/M on particulate emissions. The impact on air toxics is modeled
through a change in base
hydrocarbon emissions.) The model has the capability of modeling the impact of up to
seven different exhaust and evaporative emission I/M programs on calculated
emission factors. By defining multiple I/M programs, the user can model different
requirements on different types and ages of vehicles or different requirements in
different calendar years.

The model also allows users to enter a number of I/M program parameters to better
model specific I/M program features. These parameters include:

Ability to model annual or biennial I/M programs.
Ability to model Idle, 2500/Idle, ASM, IM240, and onboard diagnostic (OBD)
exhaust I/M programs.
Ability to model gas cap (GC), fill-pipe pressure test (FP), and OBD check
evaporative I/M programs.
Ability to control model year coverage.
Ability to control vehicle class coverage (only gasoline-fueled vehicles can be
modeled for I/M).
Ability to vary the failure rate of the exhaust I/M program for pre-1981 model
year vehicles.
Ability to vary the compliance rate of the I/M program.
Ability to vary the waiver rate of the I/M program.
Ability to vary the cutpoints used in an IM240 program.
Ability to account for the effect of exempting old vehicles from program
requirements.
Ability to account for the effect of exempting new vehicles from program
requirements (referred to here as a 'grace period').
Ability to eliminate the effects of technician training on exhaust I/M performance.
Ability to assemble all of the I/M program parameters into a single external input
file.

For an exhaust I/M program, all program parameters are derived from that program's
user-input parameters or from the program's default parameters. The program is not
affected by user-input parameters for other I/M programs (exhaust or evaporative). 

However, an evaporative I/M program that runs simultaneously and on the same
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model years as an exhaust program may be affected by the exhaust program. An
evaporative program will use its own user-input parameters, but if those are not
provided, the evaporative program will use the simultaneous exhaust program's user-
input parameters; if those are not provided, the evaporative program will use model
default parameters. To make sure that the parameters governing an evaporative I/M
program do not change when other I/M program commands are modified, always
specify the evaporative I/M parameters explicitly.

To manage inspection / maintenance programs:

1. Select a run.
2. From the Regulations menu select Inspection / Maintenance Programs.
3. Manage the inspection / maintenance programs.
4. Click the Efficiency button to enter correction factors that reduce the exhaust I/M
credit for test and repair programs by specified input percentages.
4.1. Select the I/M effectiveness for hydrocarbons from 0 to 100% inclusive.
4.2. Select the I/M effectiveness for carbon monoxide from 0 to 100% inclusive.
4.3. Select the I/M effectiveness for nitrogen oxides from 0 to 100% inclusive.
4.4. Select Ok to save the changes and close the dialog box. Select Cancel to close
the dialog box without saving any changes.

5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. By default, the program does not use any inspection or
maintenance programs.

7.4.2 Add program

Adds a new inspection / maintenance program. Up to 7 different programs can be
simultaneously used in a project.



Regulations 119

© 2012 TechnoLogismik i

To add a new inspection / maintenance program:

1. By pressing the Add button, the add new program form shows up.
2. Click the Settings tab.

3. Enter the name of the program.
4. Select the program start year from the drop-down list. This parameter can range
from calendar year 1960 through calendar year
2051. The start year represents the year in which a particular group of vehicle types
and model years were first tested within an evaporative or exhaust I/M program. If a
program changes over time for a particular model year & vehicle type, the subsequent
program changes should be modeled in separate model runs with separate I/M
program descriptions that cover the relevant evaluation years, such that each program
for a vehicle type/model year group is listed with the original I/M start year. This
assures that the model will model the uninterrupted testing of these vehicles, rather
than modeling each program change as a completely new program.
5. Select the program end year from the drop-down list. This parameter can range
from calendar year 1960 through calendar year
2051.
6. Select the frequency of the inspections from the drop-down list. Inspections may
occur every year or every other year.
7. Select the program type from the drop-down list:

TRC for a 'Test and Repair (computerized)' program,
TRM for a 'Test and Repair (manual)' program,
T/O for a 'Test Only' program.

The I/M program type must be TRC or TRM if the effectiveness command is to be
used.
8. Select the I/M inspection test type from the drop-down list.
9. Select the first model year that will be covered by the I/M program to be
modeled. This parameter can range from 1941 to 2050 inclusive.
10. Select the last model year that will be covered by the I/M program to be
modeled. This parameter can range from 1941 to 2050 inclusive.
11. Enter the stringency from 10 to 50%. This command defines the expected
exhaust inspection failure rate for pre-1981
model year vehicles covered by the I/M program. Vehicles in circulation after 1981
ignore this command.
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12. Enter the compliance rate with the particular I/M program from 50 to 100%.
13. Enter the waiver rates pre 1981 parameter.
14. Enter the waiver rates post 1981 parameter.
The waiver commands specifies the percentage of vehicles that fail an initial I/M test
and do not pass a retest but receive a certificate of compliance. There is no default for
this command for exhaust I/M programs. It is required if the user wishes to model an
exhaust I/M program. If the I/M PROGRAM command describes an exhaust program
and this command is not present, the model will issue an error message and the run
will be aborted.
If the I/M PROGRAM command describes an evaporative program, but waiver rates are
not specified for the evaporative program and an exhaust program is not in effect for a
specific vehicle class and model year, MOBILE6 will use default values of 5 percent for
the evaporative program. However, if waiver rates are not provided for an evaporative
program but are provided for a simultaneous exhaust
program, the model will use the exhaust program waiver rates to compute evaporative
benefits on the vehicles and model years covered by both the exhaust and evaporative
programs.
The valid input range for waiver rate percentages are between 0 percent and 50
percent. The values are entered into the program as percentages that include a
decimal. If either of the waiver rates exceed 50.0 percent, the program will issue an
warning message.
15. Select the exemption age from the drop-down list.
This command allows users to specify the age at which vehicles become exempt from
the I/M program they wish to model. This is similar in effect to setting the last model
year covered by the I/M program using the first and last model year command.
However, it allows vehicles over a given age to be exempted when evaluating multiple
calendar years without requiring separate runs using different
values for the first and last model year parameters.
By default, the exemption age is equal to 25 years old (in effect, under a default
scenario, vehicles never become exempt from I/M because of age). If an exhaust I/M
program is in effect and the user enters an exemption age for the program, the
exhaust program exemption age will apply to the same vehicles and model years in
any simultaneous evaporative I/M program, unless a different exemption age is
explicitly entered for the evaporative I/M program.
Including or exempting vehicles older than 25 years has no effect on I/M program
benefits because the model does not calculate emissions for vehicles older than 25
years. Enter the exemption age for all evaporative I/M programs. If this command is
not entered for an evaporative I/M program, the value used in the model may change
when commands for other I/M programs are added or modified.
16. Select the grace period from the drop-down list.
This command allows users to specify the age at which vehicles first become subject
to I/M testing (newer vehicles are exempt). By default the grace period is equal to 1
year old.
If an exhaust I/M program is in effect and the user enters a grace period for the
exhaust program, the exhaust program grace period will apply to the same vehicles
and model years in any simultaneous evaporative I/M program, unless a different
exemption age is explicitly entered for the evaporative I/M program.
17. Activate the ignore technician training option to eliminate the I/M credit that
the model assigns to a technician training program.
The model assigns full I/M credit for technician training. This command is appropriate
only if the I/M program does not conduct or plan to conduct a technician training
program.
18. Click on the Vehicles tab.
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19. Select the vehicle categories that will be included in the program. Use the quick
keys Select All, Select None and Invert Selection to select all vehicles, select no
vehicles and select the unselected vehicles and vice versa respectively.
20. Only if in the user selected in step 8 IM240 inspection type, then by pressing the
Edit button the user can enter cutpoint data.
20.1. Enter the desired values directly in the table.
20.2. Optionally, click on Clear to delete all data that are present in the table.
20.3. Select Ok to save the changes and close the dialog box. Select Cancel to close
the dialog box without saving any changes.

21. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
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3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

7.4.3 Delete program

The selected from the list I/M program is removed.

To delete an existing I/M program:

1. Select from the list of inspection / maintenance programs the record which is about
to be removed.
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2. When the user clicks Remove it is asked whether he confirms the removal of the
selected record, if the confirmation option has been activated in the general
preferences.
3. The selected record is removed.

7.4.4 Change Program

The user can change the data of an existing inspection / maintenance program.

To change an existing inspection / maintenance program:

1. Select the record from the list of I/M programs that is about to change.
2. Press the Change button to view the edit form.
3. The user can make any changes.
4. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

7.5 1990 Clean air act requirements

This command allows users to model vehicle emissions as if the Federal Clean Air Act
Amendments of 1990 had not been implemented. This command may be used in
conjunction with the modeling of state Rate of Progress (ROP) plans. By default, the
model assumes that the Clean Air Act (CAA)Amendments of 1990 did occur.

The model has been updated to include a number of vehicle and fuel requirements
mandated by the 1990 Clean Air Act Amendments. These include Tier1, low emissions
vehicle (LEV), and Tier2 tailpipe exhaust emission standards, and new evaporative
emission test procedure requirements. Nevertheless, for some modeling purposes,
emission factors for future calendar years in the absence of the requirements imposed
by the 1990 CAA amendments may be needed (e.g., to support ROP plans).

By using this command, the user can disable the following effects in the model:

The effect of all Federal exhaust tailpipe standards after Tier0 standards or the
1993 model year will be shut off. All model years subsequent to the 1993 model
year will be assigned the 1993 model year emission factor. The 1993 model year
was selected because it is the last year that was unaffected by the CAA
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amendments.
The evaporative emission benefits from the Enhanced Evaporative Test procedure
will be eliminated. This affects running loss, diurnal, hot soak, resting loss, and
refueling emission factors.
The emission benefits from the Supplemental Federal Test Procedure for both off-
cycle and air-conditioning emission effects will be eliminated if the command is
issued.
The effects of OBD will be eliminated, and an OBD I/M program will not be
allowed. Evaporative OBD I/M programs are also not allowed when this command
is used. Only Exhaust and Evaporative I/M programs that existed in calendar year
1990 can be modeled, and they can be modeled for model years 1996 and later.
The fuel sulfur level is set to 300 parts per million (ppm) for all model years
greater than 1993.
The detergent gas emission effect is eliminated.
The 1995 model year tampering rates are extended past the 1995 model year /
calendar year. For these years, the rates that prevailed in the 1995 model year
are used.
Cold temperature CO effects are affected. These will be set to 1993 model year
rates.

The following effects are NOT affected by the NO CLEAN AIR ACT command:

Heavy-duty vehicle off-cycle effects (defeat device), and heavy-duty vehicle
conversion factors are unaffected by this command.
The model's correction factors for average speed are unaffected by this command.
Facility cycle or roadway effects are unaffected by this command.
Fleet effects such as fleet turnover, changes in VMT between classes, mileage
accumulation effects, and registration distributions are unaffected by this
command.

If this command is entered in conjunction with an inspection / maintenance program,
the OBD I/M test type is not allowed for any model years. Only exhaust-based
emission tests are allowed, such as the IDLE, 2500/IDLE , or non-OBD Evaporative
test programs, such as the gas cap check. An error message will result if the user
enters an OBD-based I/M program, or if the user enters an I/M240 or ASM type
program.

When this command is used, the model year coverage for exhaust-based I/M emission
test programs may extend to 1996 and newer model years.

To configure 1990 Clean air act requirements:

1. Select a run.
2. From the Regulations menu, select the 1990 Clean Air Act Requirements.
3. Select or unselect the option Disable the 1990 clean air act amendments.
4. Optionally, press the Default button to enter the default value of the parameter
which is to apply the clean air act.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.



Regulations 125

© 2012 TechnoLogismik i

NOTE: This data is optional. If not entered, the program takes into account the
amendments set forth in the clean air act. For countries other than the US, users
should always disable this option.

7.6 Heavy duty diesel vehicle emission effects

The user can configure several options related to the heavy-duty diesel vehicle Nox
off-cycle emission effects.

To configure the heavy-duty diesel vehicle emission effects:

1. Select a run.
2. From the Regulations menu select Heavy Duty Diesel Vehicle Emission Effects
.
3.1. Enable or disable the effects of the HDDV Nox off-cycle emission effects.

This command allows users to turn off the effects of the heavy-duty diesel vehicle Nox
off-cycle emission effects (defeat device emissions). It affects only Nox emissions from
vehicle classes 17 through 23, and has an appreciable emission effect only on vehicle
classes 22 and 23. It also only affects the Nox emission results from calendar years
1989 through 2028 by affecting model years 1988
through 2003.
By default, the model uses national (U.S.) estimates to report the effects of off-cycle
Nox emissions from heavy-duty diesel vehicles. The default setting for this command
is to include these effects. It is recommended that most users do not activate this
option. EPA’s best estimate for the effects of heavy-duty vehicle Nox off-cycle
emissions has been programmed into MOBILE6 as the default input. Most users will
not need to model the anything other than the default emission effects which include
an off-cycle emission contribution. However, this command has been added to the
model to allow users the ability to easily shut off the reporting of the Nox off-cycle
emissions should they need the capability.

3.2. Enable or disable the effects of the pull ahead mitigation program.

This command allows the user to turn off the effects of the Pull Ahead mitigation
program used to reduce heavy-duty diesel vehicle Nox off-cycle emissions. It affects
only Nox emissions from vehicle classes 17 through 23, and has an appreciable
emission effect only on vehicle classes 22 and 23. It also only affects the Nox emission
results from model years 2002 and 2003.

By default, the model uses national (U.S.) estimates to report the effects of off-cycle
Nox emissions pull ahead from heavy-duty diesel vehicles. The default setting for this
command is to include these effects. It is recommended that most users do not
activate this option. EPA’s best estimate for the effects of heavy-duty vehicle Nox
off-cycle emissions and the effects of the EPA Pull Ahead mitigation program have
been programmed into the model as the default input. The Pull Ahead program
modeled by the program is the best estimate at the time of the release of the model of
what the actual program will achieve. It was assumed to have only partial
compliance by the engine manufacturers in both model year 2002 and 2003, and
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achieve an average Nox emission standard of 6.0 g/bhp-hr for those vehicles which
comply. It does not give the user any capability to change the compliance rates, the
implementation schedule or the emission level of 6.0 g/bhp-hr.

Care should be taken when using this command since it disables EPA's best estimates
for the effect of the Nox off-cycle emissions mitigation strategy called Pull Ahead. The
command also has interactive effects with the previous option, and should not be used
in conjunction with this command.

3.3. Enable or disable the effects of the rebuild mitigation program.

This command allows the user to turn off the effects of the Rebuild mitigation program
used to reduce heavy-duty diesel vehicle Nox off-cycle emissions. It affects only Nox
emissions from vehicle classes 17 through 23, and has an appreciable emission effect
only on vehicle classes22 and 23. It also only affects the Nox emission results from
model years 1993 through 2003.

By default, the model uses national estimates to report the effects of off-cycle Nox
emissions Rebuild program for heavy-duty diesel vehicles. The default setting for this
command is to include these effects at an effectiveness rate of 90%. It is
recommended that most users do not activate this option.

EPA’s best estimate for the effects of heavy-duty vehicle Nox off-cycle emissions and
the effects of the EPA Rebuild mitigation program have been programmed into the
model as the default input. The Rebuild program modeled by the program is the best
estimate at the time of the release of the model of what the actual program will
achieve. It was assumed to have an effectiveness rate of 90 percent, cover 1994
through 2003 model years, begin after five years of service for class 8a and 8b trucks
and 12 years for medium duty diesel trucks, and rebuild engines to a standard of 6.00
g/bhp-hr. The command does not give the user the ability to change any of these
parameters. The effective parameter (90%) can be changed with the next option.

Care should be taken when using this command since it disables EPA's best estimates
for the effect of the Nox off-cycle emissions mitigation strategy called Rebuild. The
command also has interactive effects with the command described in 3.1, and should
not be used in conjunction with this command. This command also cannot be used in
conjunction with the next option.

3.4. Enter the rebuild program effectiveness.

This command allows the user to change the Rebuild program effectiveness rate used
to reduce heavy-duty diesel vehicle Nox off-cycle emissions. It affects only Nox
emissions from vehicle classes 17 through 23, and has an appreciable emission effect
only on vehicle classes 22 and 23. It also only affects the Nox emission results from
model years 1993 through 2003.

The model uses national (U.S.) estimates to report the effects of off-cycle Nox
emissions Rebuild program for heavy-duty diesel vehicles. The range of legal values
for this input parameter are 0.01 to 0.90. The default setting for this command is to
include these effects at an effectiveness rate of 90%. It is recommended that most
users do not activate this option.

EPA’s best estimate for the effects of heavy-duty vehicle Nox off-cycle emissions and
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the effects of the EPA Rebuild mitigation program have been programmed into the
model as the default input. This default effectiveness level is 90 percent. This
command allows the user to vary the Rebuild Effectiveness to perhaps better fit a local
situation. However, it is unlikely that most users will have good local data on this
parameters, and are thus, encouraged to not use it.

4. Optionally, press the Default button to enter the default values of the parameters.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional.

7.7 Tier2 emission standards and fuel requirements

7.7.1 Disable Tier2

This command allows the user to disable the Tier 2 emission standards and fuel sulfur
requirements. By default, the model accounts for the Tier 2 emission standards and
fuel requirements if the user does not use this command. Use of this command causes
the model to calculate emission factors without the effects of the Tier 2 standards. The
model will continue modeling the NLEV vehicle and truck program through 2050 with
the default fuel sulfur levels for calendar year 2000 (300 ppm for conventional
gasoline, 150 ppm for reformulated gasoline).

To disable Tier 2:

1. Select a run.
2. From the Regulations menu select the Tier2 Standards And Fuel Requirements
menu.
3. From the pop-up menu select Disable Tier2.
4. Make the appropriate change.
5. Optionally, press the Default button to enter the default value of the parameter.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not entered, the program uses Tier2.

7.7.2 Tier2 evaporative emissions phase-in

This command allows the user to replace the default phase-in fractions (by
certification bin) for the Tier 2 evaporative emission standards, allowing different
phase-in schedules to be modeled. This command is also necessary to model the
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evaporative emission effects of California’s LEV II requirement. By default, the model
uses the default Tier2 certification standard phase-in schedule.

The columns reflect model years 2004 through 2015, inclusive. The rows reflect
phase-in percentages by the 5 light-duty vehicle classes (LDV/LDT1/LDT2/LDT3/
LDT4). Each of the phase-in fractions must be between zero and one, inclusive. The
sum of the phase-in fractions must be between 0.999 and 1.001 (inclusive) for a
given vehicle, model year, and pollutant, or the input data will be rejected and the
previously stored values will be used. An error message will be sent to the descriptive
output when the user supplied input for the alternate Tier2 phase-in fractions has
been rejected.

To enter the data:

1. Select a run.
2. From the Regulations menu select the Tier2 Standards And Fuel Requirements
menu.
3. From the pop-up menu select Tier2 Evaporative Emissions Phase-In.
4. Enter the desired values directly in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional.

7.7.3 Tier2 exhaust emissions phase-in

This command allows the user to replace the default phase-in fractions (by
certification bin) for the Tier 2 exhaust emission standards, allowing different phase-in
schedules to be modeled. This command is also necessary to model the exhaust
emission effects of California's LEV II requirement. By default the model uses the
default Tier2 certification standard phase-in schedule.

The rows reflect phase-in percentages by a) 12 certification bins, b) 3 pollutants (HC/
CO/Nox), and c) 5 light-duty vehicle classes (LDV/LDT1/LDT2/LDT3/LDT4). For
example, the first 12 rows of the matrix contain bins 1-12 for LDV HC; the second 12
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rows contain bins 1-12 for LDV CO; the third 12 rows contain bins 1-12 for LDV Nox;
the fourth 12 rows contain bins 1-12 for LDT1 HC, etc.

In terms of model operation, each fraction must be between zero and one, (inclusive).
The sum of the phase-in fractions must be between 0.999 and 1.001 (inclusive) for a
given vehicle class, model year, and pollutant, or the input data will be rejected and
the previously stored values will be used. An error message will be generated when
the user-supplied input for the alternate Tier2 phase-in fractions has been rejected.
Beyond model execution, the user must ensure that alternate phase-in assumptions
for the Tier 2 requirement satisfy the fleet-average and minimum phase-in provisions
of the Tier 2 rule; the model does not check for the latter condition. As discussed in
the model's technical report M6.EXH.004, the Tier 2 requirement contains 10 actual
certification bins; 8 'final', and 2 'interim'. Bins 1-8 are the final bins (lowest standard
to highest), and Bins 9-10 are the interim standards. Under the default scenario of the
model, Bins 11-12 are used only to account for provisions of the HC interim standards
for LDT3s and LDT4s which necessitate multiple standards being assigned to one bin.
The user can 'activate' these bins through the Tier2 Certification command.

Under the default condition, the certification standard for Bin 1 is 0. However, zero-
emitting vehicles (ZEVs) should not be assigned to this bin, because overall emissions
as calculated by the model will not be zero. Instead, the user would need to specify
the percentage of ZEVs under the post 1994 alternate schedule command and use this
command to apportion the non-ZEVs in Bins 2-10. In this scenario the non-ZEV
phase-in fractions would have to be normalized in the input file containing the phase-
in schedule so that they sum to one across vehicle class, model year, and pollutant.

To enter the data:

1. Select a run.
2. From the Regulations menu select the Tier2 Standards And Fuel Requirements
menu.
3. From the pop-up menu select Tier2 Exhaust Emissions Phase-In.
4. Enter the desired values directly in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional.

7.7.4 Alternative Tier2 certification standards

This command allows the user to specify alternative Tier 2 50,000 mile certification
standards and must be used to model the effects of California's LEV II requirement.
Since the standards under the Tier 2 rule are final and therefore static, the intended
use of this command is to model the effects of California's LEV II program. By default,
the model uses the default Tier2 certification standards.

This command is used to specify an external input file containing values that will
override the default Tier 2 certification standards. The input file called by this
command will read in 50,000 mile certification standards for each of the 10
certification 'bins' (interim and final) for each light-duty vehicle type (Classes 1
through 5) and pollutant (HC, CO and Nox). The Tier 2 requirement contains 10 actual
certification bins; 8 'final', and 2 'interim'. Bins 1-8 are the final bins (lowest standard
to highest), and Bins 9-10 are the interim standards. Under the default scenario of the
program, bins 11-12 are used only to account for provisions of the HC interim
standards for LDT3s and LDT4s which necessitate multiple standards being assigned to
one bin. The user can 'activate' these bins through the command, a necessary step for
modeling the California LEV II program.

The alternate certification standards supplied under T2 CERT are checked to ensure
that they are greater than or equal to zero. Negative values or missing values result in
all user supplied input values being rejected. An error message will be sent to the
descriptive output when user supplied input has been rejected.

To enter the data:

1. Select a run.
2. From the Regulations menu select the Tier2 Standards And Fuel Requirements
menu.
3. From the pop-up menu select Alternative Tier2 Certification Standards.
4. Enter the desired values directly in the table.
5. Optionally, click on Clear to delete all data that are present in the table.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.

To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.
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NOTE: This data is optional.

7.8 Post 1994 model vehicle standards

This command allows the user to input optional 1994 and later fleet penetration
fractions for light-duty gasoline vehicles under the Tier 1, NLEV (or California LEV 1),
and Tier 2 emission standard programs. By default, the model uses the default
certification standard phase-in schedule for the Tier 1, NLEV and Tier 2 programs.

This command allows for optional user input of light-duty gas 1994+ model year
emission standard implementation values. These values are fleet penetration fractions
of the eleven vehicle certification standard categories under the Tier 1, NLEV (or
California LEV I), and Tier 2 vehicle emission programs. For a given model year and
light-duty gas vehicle type the eleven fractions must add up to 1.000. The standards
types are:

1. Tier0
2. Intermediate Tier1
3. Tier1
4. Tier2
5. Intermediate TLEV
6. TLEV
7. Intermediate LEV I
8. LEV I
9. Intermediate ULEV I
10. ULEV I
11. ZEV (zero emitting vehicle)

It should be noted that the category 'Tier 2' under this command only denotes the
fraction of light-duty vehicles and trucks participating in the Tier 2 program. The full
'bin' implementation of the Tier 2 vehicle program (or LEV II program) would be
modeled using the Tier 2 input commands. However, this command must be used to
model the effect of zero-emitting vehicles under the LEV I or LEV II programs.

The model does not have separate emission estimates for the intermediate useful life
standards. The 'intermediate' standard level categories use the emission estimates for
the final category; e.g., Intermediate Tier1 type uses the Tier1 emission level.
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To enter the data:

1. Select a run.
2. From the Regulations menu select Post 1994 Model Vehicle Standards.
3. Select a vehicle class from the drop-down list.
4. Enter the desired values directly in the table.
5. Repeat steps 3 and 4 until all values have been entered.
6. Optionally, click on Clear to delete all data that are present in the table.
7. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

NOTE: This data is optional.

7.9 2007 heavy duty vehicle emissions requirements

The following command overrides the default settings for the 2007 Heavy Duty Vehicle
emission standards. It allows the user to disable the 2007 heavy duty vehicle emission
standards. By default, the model will account for the 2007 heavy duty vehicle
emission standards.

Use of this command causes the model to calculate emission factors without the
effects of the 2007 heavy duty vehicle emission standards. These standards and the
associated lower sulfur diesel fuels will begin effecting emissions in 2008 and will be
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fully implemented in all vehicles manufactured in 2009 and subsequent years.

To disable or enable the 2007 heavy duty vehicle emissions requirements:

1. Select a run.
2. From the Regulations menu select 2007 Heavy Duty Vehicle Emissions
Requirements.
3. Disable or enable the given option.
4. Optionally, press the Default button to enter the default value of the parameter.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. By default, the model will account for the 2007 heavy
duty vehicle emission standards.
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8 Fuel

8.1 Fuel menu

Fuel commands allow users to model the impact of various gasoline fuel parameters.
In particular, the following options are offered via this menu:

Fuel program
o User defined program

Gasoline sulfur content
Diesel sulfur content
Oxygenated fuels
Fuel reid vapor pressure
Effective season
Air toxics
o Gas aromatic

o Gas olefin

o Gas benzene

o Vapor percentage at 200F

o Vapor percentage at 300F

o Gasoline fuel oxygenate type

o Oxygenated fuels RVP waiver

8.2 Fuel program

8.2.1 Fuel program

This command allows users to specify one of two Tier 2 sulfur phase-in schedules, to
model the impact of a reformulated gasoline (RFG) program, or to specify sulfur
content for gasoline after 1999. By default the model assumes that there is no RFG
program in place and applies the standard Tier 2 gasoline sulfur phase-in schedule for
calendar years after 1999. This default condition is described below as 'Conventional
Gasoline East.'

This command allows four options. Users may specify one of two Tier 2 sulfur phase-in
schedules, model the effect of an RFG program, or directly supply values for gasoline
sulfur content after 1999. Users select the desired option by entering an integer
following the command name. This data entry is in free column format. Some options
also require additional input data, as described below. The options and their
associated numbers are:

1. Conventional Gasoline East
2. Reformulated Gasoline
3. Conventional Gasoline West
4. User-supplied gasoline sulfur levels

Each of these options and its input requirements are described in detail below. 

Conventional Gasoline East
This is the model default. It supplies post-1999 gasoline sulfur levels by year under
the phase-in schedule prescribed by the Tier 2 rule for most states.
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Conventional Gasoline West
This option supplies post-1999 gasoline sulfur levels by year under the phase-in
schedule prescribed by the Tier 2 rule for specific western states (i.e., Alaska,
Colorado, Idaho, Montana, New Mexico, North Dakota, Utah, Wyoming) and bordering
counties in other states.

Reformulated Gasoline (RFG)
This option should be used to model the effects of an RFG program (Unless the user
intends to model air toxics, in which case the RFG parameters must be entered
explicitly. Like conventional gasoline, RFG must meet fuel volatility requirements that
vary by geographic region (see 'Volatility Regulations for Gasoline and Alcohol Blends
Sold in Calendar Years 1992 and Beyond,' 55 FR 23658, June 11, 1990). Because the
RFG option often sets fuel volatility and overrides the FUEL RVP label, the RFG option
requires the user to indicate which region (north or south) is being modeled. The exact
fuel parameters modeled for RFG depend on the geographic region, the calendar year,
and the season.

Notes for Reformulated Gasoline Parameter tables:

(1) The Clean Air Act defines the RFG 'Summer' as May 1 through September 15.
'Winter' is the rest of the year. The model will generally determine which fuel season
to model using the value input for evaluation month (1 = January and indicates
winter; 7 = July and indicates summer). However, the user can override the fuel
season indicated by the evaluation month by using the season command.

(2) For most of the fuel parameters, the year listed here indicates the calendar year
for which the fuel parameter is typical. However, the 'Maximum Sulfur' value
represents the maximum sulfur level ever experienced by a vehicle, regardless of the
fuel level in the calendar year of the model run. Thus, the 'year' in these tables is used
to assign the maximum sulfur values to the appropriate vehicle model year. The
maximum sulfur effect is not calculated for 1999-and-earlier vehicles, so no maximum
sulfur level is needed for these years.

(3) During the winter fuel season, the user may override the default RFG parameters
for oxygenated fuels if the user-supplied oxygenated fuel parameters have a combined
oxygenate for ethanol and ether blends greater than 2.1 percent by weight and the
combined oxygenate market share is 100 percent.

(4) The winter RFG sulfur values listed here and used in the model when the RFG
option is selected are appropriate for most of the United States, but they are not
correct for states with 'western' Tier 2 fuel.

(5) In the winter RFG season, user input for sulfur content will override the default
average fuel sulfur for calendar years 1999-and earlier. This is not true for summer
RFG. 

User-supplied Gasoline Sulfur Levels
This option allows the user to directly specify the average and maximum sulfur levels
for calendar years 2000 and later if these are known to differ from RFG or the
conventional fuels programmed into the model. For calendar years prior to 2000, the 
sulfur content command must be used.
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The command affects sulfur content prior to calendar year 2000 only when RFG is
selected. In general, use the sulfur content command to define the sulfur content of
gasoline in calendar years before 2000. The model treats the command option 4 as a
conventional gasoline program with alternate sulfur levels. If an RFG program is
desired with alternate sulfur levels, the command option 4 lets users enter the sulfur
levels and alter the other non-sulfur fuel parameters through the fuel rvp and
oxygenated fuels and/or air toxics fuel commands to
approximate the non-sulfur effects of RFG.

It is not appropriate to use the command option 2 to choose a Phase 2 (calendar year
2000 or later) RFG program for western Tier 2 sulfur content phase in states (listed
above). Users wishing to model western RFG will need to specify all of the fuel
parameters (sulfur content, oxygen content and RVP) separately for each calendar
year they wish to evaluate. In winter season scenarios, users should use the command
to choose 'Conventional Gasoline West' to obtain the appropriate winter sulfur levels.

Then, using the oxygenated fuels command, users must enter either the winter RFG
oxygenated fuel parameters described above or a local oxygenated fuels program that
satisfies the RFG rule. The fuel rvp command is used to specify fuel volatility. Modeling
western RFG in summer will require the user to specify the sulfur levels using the
command option 4, because the summer average sulfur will be the same as those
shown above for RFG, however, the maximum sulfur values will be those shown for the
western phase in states. As with winter, the user must specify the appropriate oxygen
content and fuel RVP levels shown above for RFG using the oxygenated fuels and
FUEL RVP commands. To model air toxics emissions Western RFG, users should make
the appropriate adjustments to the air toxics fuel command.

To enter a fuel program:

1. Select a run or a scenario.
2. From the Fuel menu select Fuel Program.
3. Select the desired program. If N/A is selected, then the command is deactivated
and the Conventional Gasoline East default value is selected.
4. If the reformulated gasoline is selected, then the region must also be specified
(North or South).
5. If the user supplied gasoline sulfur levels is selected, then the user must also
supply the necessary data as described in the next paragraph.
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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8.2.2 User defined program

Enter the maximum and mean concentrations of sulfur in the fuel in ppm.
The values are typed directly in the table. The table is not active until the user selects 
User supplied gasoline sulfur levels from the drop-down program list. Optionally,
click on Clear to delete all data that are present in the table.

Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

To import data from an external file:

1. Click Import to open the file import form.
2. Select the path of the file.
3. Select the file type from the Files of type drop-down list. The default option is
"Text file" with the extension .txt.
4. Select the file by clicking on it.
5. Select Open to open the selected file. Select Cancel to cancel the operation.
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To export data to an external file:

1. Click Export to open the file export form.
2. Select the path of the file.
3. Type the filename in the File name text box.
4. Select Save to save the file with the selected filename and path. Select Cancel to
cancel the operation.

8.3 Gasoline sulfur content

This command allows the user to enter the sulfur content of gasoline fuel for calendar
years through 1999. This input is valid only through the 1999 calendar year. For
calendar years after 1999, the model will ignore this input.

The model will accept sulfur contents for 30.0 ppm through 600.0 ppm. If a sulfur
level outside that range is entered, the model will round to the (appropriate) end point
(30 ppm or 600 ppm) and generate a warning message. To enter values for years after
1999, the fuel program command must be used.

Using this command will override the default fuel sulfur content (300 ppm) used for
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Reformulated Gasoline in calendar years 1995 through 1999 (Phase 1) in both Regions
(North and South) and in both winter and summer seasons. The user should note that
this command and the diesel sulfur commands are not completely analogous. The
command applies only the 1999 and earlier calendar years, while the diesel sulfur
command applies to all calendar years.

To enter the gasoline sulfur content:

1. Select a scenario.
2. From the Fuel menu select the Gasoline Sulfur Content.
3. Enter the desired value between 30 and 600 ppm.
4. Optionally, press the Default button to enter the default value of the parameter.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not entered, the model will use the default value which
is 300 ppm.

8.4 Diesel sulfur content

This command provides for the input of the average diesel fuel sulfur level for the
scenario. The value is specified in units of parts of sulfur per million. This value can
range from 0.01 ppm to 5000 ppm. The user should note that the gasoline sulfur and
diesel sulfur commands are not completely analogous. The gasoline sulfur command
applies only the 1999 and earlier calendar years, while the diesel sulfur command
applies to all calendar years.

The diesel fuel sulfur content value does not affect the calculation of HC, CO, and NOX
emissions or of air toxic compounds (except when calculated as a ratio to PM).

If particulate emissions are being estimated, increasing the amount of sulfur in the
vehicle fuel has the effect of directly increasing estimated sulfate particulate
emissions.

To enter the diesel sulfur content:

1. Select a scenario.
2. From the Fuel menu select the Gasoline Sulfur Content.
3. Enter the desired value between 0.01 and 5000 ppm.
4. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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NOTE: This data is optional.

8.5 Oxygenated fuels

This command permits users to model the effects of oxygenated gasoline on exhaust
emissions for all gasoline-fueled vehicle types. If the command is not used and the 
fuel program command is not used to select a RFG program, the program assumes
that the fuel used by gasoline-fueled vehicles does not contain an oxygenate and does
not calculate an oxygenated fuels benefit.

The effect of oxygenated fuels on emissions depends on several fuel parameters that
are specified by this command. These include whether the oxygenate is an alcohol or
ether blend; the amount of oxygen in the fuel; and the market share of oxygenated
fuels. In certain cases, the presence of oxygenate in fuel can affect fuel RVP,
generating an additional emission effect.

The user need to specify whether a Reid vapor pressure (RVP) waiver has been
granted to allow “splash” blending of alcohol-based oxygenates. If a waiver has not
been granted, then alcohol-based oxygenated fuels must meet the same RVP
requirements as non-oxygenated fuels sold in the area. If a waiver has been granted,
then alcohol-based oxygenated fuels are allowed to exceed the RVP requirements by
up to 1 pound per square inch (psi), and the user-input RVP is increased to account
for the market share of the higher RVP fuel.

If the market share of the oxygenated fuels is not 100%, then the average RVP of fuel
will be increased by a commingling effect from the
mixing of oxygenated and non-oxygenated fuels, even if there is no RVP waiver for
oxygenated fuels.

If the user specifies a RFG program using the fuel program command, then the
oxygenated fuel parameters of that program take precedence over this command. 

To enter oxygenated fuels data:

1. Select a run or a scenario.
2. From the Fuel menu select Oxygenated Fuels.
3. Enter the ether blend market share, expressed as a decimal fraction. The range is
0.000 to 1.000..
4. Enter the alcohol blend market share, expressed as a decimal fraction. The range
is 0.000 to 1.000..
5. Enter the average oxygen content of ether blend fuels, percent weight,
expressed as a decimal fraction. The range is 0.000 to
0.027.
6. Enter the average oxygen content of alcohol blend fuels, percent weight,
expressed as a decimal fraction. The range is 0.000
to 0.035.
7. Select if Reid vapor pressure waiver is granted to allow splash blending of alcohol
based oxygenates or not.
8. Optionally, press the Default button to enter the default value of the parameter.
9. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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NOTE: This data is optional. This data cannot be used together with the air toxics
options found in the project properties. Instead of this command the user should use
the oxygenate command.

8.6 Fuel reid vapor pressure

This command allows users to specify fuel RVP for the area to be modeled There is no
model default for fuel RVP. Users must enter a value for all scenarios (in the Run
section) or for each scenario (in the Scenario section) of each model command input
file.

RVP is one measure of the volatility of gasoline. Exhaust and especially non-exhaust
emissions vary with fuel volatility. The FUEL RVP command specifies the value of RVP
(in psi) representing the prevailing average fuel volatility for the geographic area of
interest. The RVP value entered must reflect the average in-use RVP of gasoline in the
region of the country being modeled. The RVP value can be between 6.5 psi and 15.2
psi, inclusive. If the user enters a value outside this range, the model will round to the
appropriate endpoint (6.5 psi or 15.2 psi) and will generate a warning message.

However, there are federal limits on fuel RVP in ozone-producing months (May through
September), which began in 1989. For the calendar years 1989 to1991, the RVP limit
is 10.5 psi, 9.5 psi, or 9.0 psi depending on the region of the country or summer
month (see Federal Register 54 FR 11868, March 22, 1989). For calendar years 1992
and beyond, the summer RVP limit is either 9.0 psi or 7.8 psi depending on the region
or month (see Federal Register 54 FR 23658, June 11, 1990).

To enter the fuel reid vapor pressure:

1. Select a run or a scenario.
2. From the Fuel menu select Fuel Reid Vapor Pressure.
3. Enter the desired value between 6.5 and 15.2 psi.
4. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is mandatory.
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8.7 Effective season

This command identifies the effective season for the RFG calculation regardless of the
month being modeled. By default, the model assumes the season is winter when
January is selected as the evaluation month and that the season is summer when July
is selected as the evaluation month. The MOBILE6 default evaluation month is
January, so winter RFG will be modeled unless the user selects July using the 
evaluation month command or selects summer by using this command.

The effect of RFG on emissions differs in summer and winter. The season command
allows the user to override the effect of the evaluation month command on RFG
calculations, either specifying that summer RFG rules be applied when the evaluation
month is January or that winter RFG rules be applied when the evaluation month is
July. This command affects only RFG-related emission results.

The command affects results only relating to RFG. The effective season command will
have no effect on results unless the input includes a fuel program command,
indicating that an RFG program is in place.

To select an effective season:

1. Select a run or a scenario.
2. From the Fuel menu select Effective Season.
3. Select the desired effective season from the drop-down list.
4. Click the Default button to select the default value of the parameter which is
derived from the evaluation month command.
5. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not entered or if N/A is selected then its value will be
taken from the evaluation month command.

8.8 Air toxics

8.8.1 Gas aromatic

This command is required, if the air toxics command is used. Do not use this
command without the air toxics command. This command allows users to specify the
aromatic content of gasoline on a volume of fuel percentage basis.

This is the percentage of aromatic compounds in gasoline on a volume basis. An
aromatic compound is one which contains a six-carbon ring configuration of the
benzene series and related organic groups. The value supplied by the user should
include benzene and other aromatic type compounds (i.e., toluene). The valid range of
inputs is from 10% to 55%. Any values outside of this range will most likely lead to
erroneous results. A typical value for this input is in the range of 20 to 30 percent
Aromatic compounds by volume. Wintertime values are typically lower than
summertime values.
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To enter the aromatic compounds data :

1. Select a scenario.
2. From the Fuel menu select Air Toxics.
3. From the pop-up menu select Gas Aromatic.
4. Enter the percentage of aromatic compounds found in fuel.
5. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is mandatory when the air toxics command in the project properties
is used. It must be deactivated when the air toxics command is not used.

8.8.2 Gas olefin

This command is required, if the air toxics command is used. Do not use this
command without the air toxics command. This command allows users to specify the
olefin content of gasoline on a volume of fuel percentage basis.

This is the percentage of olefin compounds in gasoline on a volume basis. An olefin is
a class of unsaturated hydrocarbons, such as ethylene, having the general formula
CnH2n and characterized by relatively great chemical activity. The value supplied by
the user should include all varieties of olefins that can appear in the gasoline.

The valid range of inputs is from 0% to 30%. Any values outside of this range will
most likely lead to erroneous results. A typical value for this input is in the range of 5
to 25 percent olefin compounds by volume. Wintertime values are typically higher
than summertime values.

To enter the olefin compounds data :

1. Select a scenario.
2. From the Fuel menu select Air Toxics.
3. From the pop-up menu select Gas Olefin.
4. Enter the percentage of olefin compounds found in fuel.
5. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is mandatory when the air toxics command in the project properties
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is used. It must be deactivated when the air toxics command is not used.

8.8.3 Gas benzene

This command is required, if the air toxics command is used. Do not use the command
without the air toxics command. This command allows users to specify the benzene
content of gasoline on a volume of fuel percentage basis.

This is the percentage of benzene compounds in gasoline on a volume basis. The value
supplied by the user should include all the benzene that can appear in the gasoline.

The valid range of inputs is from 0% to 5% for conventional gasoline and 0% to 2%
for Reformulated Gasoline. Any values outside of these ranges will most likely lead to
erroneous results. A typical value for this input is in the range of 0.2 to 3 percent
benzene by volume.

To enter the benzene compounds data :

1. Select a scenario.
2. From the Fuel menu select Air Toxics.
3. From the pop-up menu select Gas Benzene.
4. Enter the percentage of benzene compounds found in fuel.
5. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is mandatory when the air toxics command in the project properties
is used. It must be deactivated when the air toxics command is not used.

8.8.4 Vapor percentage at 200F

This command is required, if the air toxics command is used. Do not use this
command without the air toxics command. This command allows users to specify the
percentage of vapor of a given gasoline fuel at 200 degrees F.

This is a gasoline fuel volatility property that identifies the percentage of vapor of a
given gasoline fuel produces at 200 degrees F. This is a common parameter reported
in fuel and refinery statistics. The E200 parameter is entered into the model as a
percentage.

The valid range of inputs is from 30% to 70%. Any values outside of this range will
most likely lead to erroneous results. A typical value for this input is in the range of 35
percent to 55 percent.

To enter the vapor percentage at 200F:

1. Select a scenario.
2. From the Fuel menu select Air Toxics.
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3. From the pop-up menu select Vapor Percentage At 200F.
4. Enter the vapor percentage at 200F found in fuel.
5. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is mandatory when the air toxics command in the project properties
is used. It must be deactivated when the air toxics command is not used.

8.8.5 Vapor percentage at 300F

This command is required, if the air toxics command is used. Do not use this
command without the air toxics command. This command allows users to specify the
percentage of vapor a given gasoline fuel produces at 300 degrees F.

This is a gasoline fuel volatility property that identifies the percentage of vapor a given
gasoline fuel produces at 300 degree F. This is a common parameter reported in fuel
and refinery statistics. The E300 parameter is entered into the model as a percentage.

The valid range of inputs is from 70% to 100%. Any values outside of this range will
most likely lead to erroneous results. A typical value for this input is in the range of 80
percent to 90 percent.

To enter the vapor percentage at 300F:

1. Select a scenario.
2. From the Fuel menu select Air Toxics.
3. From the pop-up menu select Vapor Percentage At 200F.
4. Enter the vapor percentage at 300F found in fuel.
5. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is mandatory when the air toxics command in the project properties
is used. It must be deactivated when the air toxics command is not used.

8.8.6 Gasoline fuel oxygenate type

This command is required, if the air toxics command is used. Do not use this
command without the air toxics command. This command is used to specify the
particular gasoline fuel oxygenate type, the fuel oxygenate content (in terms of
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percent by volume of the oxygenate), and the market share of the particular
oxygenate. Together with the oxygenated fuels RVP waiver command, it supersedes
the oxygenated fuels command, if the air toxics command is used. The program will
produce an error message if the both the oxygenate and oxygenated fuels commands
are used in the same run. Also, the oxygenate command cannot be used in
conjunction with the fuel program command equal to a value of '2' (an RFG program).

The oxygenate command requires fuel oxygenate content and market share
information on four gasoline fuel oxygenates. These are MTBE, ETBE, Ethanol and
TAME.

MTBE is Methyl Tertiary Butyl Ether.
ETBE is Ethyl Tertiary Butyl Ether.
ETOH is Ethanol or Ethyl Alcohol.
TAME is Tertiary Amine Methyl Ether.

If an Air Toxics run is performed, the oxygenate command supersedes the oxygenated
fuels command by weighting the MTBE, ETBE and TAME oxygen levels by the market
share, summing the result, and inserting it into the program for the first and third
parameters in the oxygenated fuels command. Likewise, the Ethanol market share and
Ethanol oxygen level in the oxygenate command are inserted for the second and
fourth parameters in the oxygenated fuels command.

Note that the model cannot model a situation where a single fuel contains more than
one oxygenate. For example a single fuel containing both MTBE and ETBE cannot be
modeled. The 'market share' parameter allows for an area fuel supply to consist of
multiple fuels, each of which may contain one oxygenate.

If the four market share values do not add up to unity, the model assumes that any
remaining portion does not contain an oxygenate. Oxygenate concentrations are
sometime expressed in terms of the percentage by weight of oxygen in the resulting
fuel blend. The following factors can be used to convert such data to be expressed in
terms of percent by volume of the oxygenate which is the form required for input to
the model:

Volume percent MTBE = Weight Percent Oxygen / .1786
Volume percent ETBE = Weight Percent Oxygen / .1533
Volume percent ETOH = Weight Percent Oxygen / .3448
Volume percent TAME = Weight Percent Oxygen / .1636

These equations assume there is only a single oxygenate in the fuel.

To enter the gasoline fuel oxygenate type data:

1. Select a scenario.
2. From the Fuel menu select Air Toxics.
3. From the pop-up menu select Gasoline Fuel Oxygenate Type.
4. Enter the gasoline fuel oxygenate type data.
5. Optionally, press the Default button to enter the default value of the parameter
(disables the command since there is no default value).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.
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NOTE: This data is mandatory when the air toxics command in the project properties
is used. It must be deactivated when the air toxics command is not used.

8.8.7 Oxygenated fuels RVP waiver

Do not use this command without the air toxics command. This command is used to
specify whether a Reid vapor pressure (RVP) waiver has been granted to allow 'splash'
blending of alcohol-based oxygenates. If a waiver has not been granted, then alcohol-
based oxygenated fuels must meet the same RVP requirements as non-oxygenated
fuels sold in the area. If a waiver has been granted, then alcohol-based oxygenated
fuels are allowed to exceed the RVP requirements by up to 1 pound per square inch
(psi), and the user-input RVP is increased to account for the market share of the
higher RVP fuel.

If the market share of the oxygenated fuels is not 100%, then the average RVP of fuel
will be increased by a commingling effect from the mixing of oxygenated and non-
oxygenated fuels, even if there is no RVP waiver for oxygenated fuels.

To enable or disable the oxygenated fuels RVP waiver:

1. Select a scenario.
2. From the Fuel menu select Air Toxics.
3. From the pop-up menu select Oxygenated Fuels RVP Waiver.
4. Make the appropriate selection.
5. Optionally, press the Default button to enter the default value of the parameter
(disables the command).
6. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

NOTE: This data is optional. If not entered then the model will assume that reid
vapor pressure waiver has not been granted.
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9 Results

9.1 Results menu

With this menu, you can perform calculations and view the results. In the Results
menu you can select one of the following options:

Calculations options
Perform calculations
Errors report
Emission factors
o Emission factors table

o Emission factors graph

Air toxic pollutants
o Air toxic pollutants table

o Air toxic pollutants graph

Particulate matter
o Particulate matter table

o Particulate matter graph

9.2 Calculations options

The calculations options refer to the format and the type of the calculations results. It
is recommended to leave the default values for these options, except for special cases.

To configure the calculations options:

1. From the Results menu select Calculations Options.
2. Make the appropriate changes.
3. Select Ok to save the changes and close the dialog box. Select Cancel to close the
dialog box without saving any changes.

Output Mode

If the option Create spreadsheet-friendly files is activated, then one or more .TAB
files will be created in the folder C:\Program Files\TechnoLogismiki\TLW2011
\Core\Mobile62\. These files will contain the results in a special format which is
suitable for importing from spreadsheet programs such as Microsoft Excel.

If the option Create database files (may take a long time) is activated, then one or
more .TB1 files will be created in the folder C:\Program
Files\TechnoLogismiki\TLW2011\Core\Mobile62\. These files will contain detailed
calculation results, depending on the settings shown in the following four tabs.
Depending on the settings, the whole procedure could last several minutes.

Tab General
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If the option Include field names is activated, then the first record in all database
files will be the names of the columns. This facilitates post-editing database files from
other programs.

The option Aggregated output, when selected, causes the creation of files with
summarized results. On the other hand, Detailed output creates files that can be
customized using all following options.

If Detailed output is selected, then the user may define the vehicle start age and
vehicle end age. Selecting N/A disables the vehicle start and / or end age. Valid
range is from 0 to 24 years. The user can also activate the Daily output option, if he
wishes results with daily time step resolution, otherwise all results will have hourly
time steps.

The options report hour start and report hour end, may be set equal to N/A
(therefore disabled) or have a value between 1 and 24. Any value other than N/A, will
constrain results to the range defined by the report hour start and report hour end.
Results referring to hours outside the report range will be excluded from the output
files. The 1st hour represents 6 am to 7 am. For example if 2 and 4 are selected for
report hour start and end respectively, the results will include values for hours 7-8, 8-
9 and 9-10 am only.

Same applies to database year start and end. The valid range is from 1928 to 2050,
while N/A disables the commands. The more database years are included, the longer
the whole procedure will take.

Vehicles Tab
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Select which categories from the 28 vehicle categories will appear in the output files.
Use the quick keys Select All, Select None and Invert Selection to select all
vehicles, select no vehicles and select the unselected vehicles and vice versa
respectively.

Click on Default to select all vehicle categories, since by default the model is
programmed to include results for all vehicle categories separately.

Emissions Tab

Select which emission categories will be included in the reports. There are 10 different
emission categories available. Use the quick keys Select All, Select None and Invert
Selection to select all emission categories, select no emission categories and select
the unselected emission categories and vice versa respectively.

Click on Default to select all emission categories, since by default the model is
programmed to include results for all emission categories separately.

Facilities Tab
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Select which facilities will be included in the reports. There are 5 different facilities
available. Use the quick keys Select All, Select None and Invert Selection to select
all facilities, select no facilities and select the unselected facilities and vice versa
respectively.

Click on Default to select all facilities, since by default the model is programmed to
include results for all facilities separately.

9.3 Perform calculations

The calculations are performed. The results appear in the main program form..

To perform calculations:

1. From the Results menu select Perform calculations.
2. The calculations take place.

9.4 Errors report

A report form shows, with all critical errors, warning messages and errors for the
current project. The tabs in this form may or may not be empty.

To view the errors report:

1. From the Results menu select Errors Report.
2. Click on the Critical Tab to view critical error messages regarding the calculations.
The user is required to correct the input data in order to remove the critical errors.
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3. Click on the Warnings Tab to view warning messages regarding the calculations. It
is highly likely that user action is required for warning messages.

4. Click on the Comments Tab to view comment messages regarding the calculations.
No user action is required for comment messages.
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5. Press Ok or Cancel to hide the form.

9.5 Emission factors

9.5.1 Emission factors

The user can view the emission factors results for the current project.

To view the emission factors results:

1. From the Results menu select Emission Factors.
2. A form with a results summary per run and scenario shows up.
3. Select the target run from the drop-down list.
4. Select the target scenario from the drop-down list.
5. Summarized results are refreshed every time the user selects a run or a scenario.
6. Click on Table to view detailed calculations results in a table form.
7. Click on Graph to view detailed calculations results in a graphical form.
8. Press Ok or Cancel to hide the form.

9.5.2 Emission factors table

The emission factors results are presented in a table form.
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To view the emission factors results table:

1. By pressing the Table button, the emission factors results table appears.
2. Select one or more scenarios. If more than one scenario is selected, then the
average values of the selected scenarios will be shown. From the Data menu, the
following sub-menus are available:

Select All Scenarios: all available scenarios in the list are selected.
Select No Scenarios: all available scenarios in the list are unselected.
Select Invert Scenarios: scenarios that are not selected are selected and vice
versa.

3. Select one or more emission categories. For every emission category selected, a
column is added in the table. From the Data menu, the following sub-menus are
available:

Select All Emissions: all available emissions in the list are selected.
Select No Emissions: all available emissions in the list are unselected.
Select Invert Emissions: emissions that are not selected are selected and vice
versa.

4. Select one or more vehicle categories from the third list. For every vehicle category
selected, a row is added in the table. From the Data menu, the following sub-menus
are available:

Select All Vehicles: all available vehicle categories in the list are selected.
Select No Vehicles: all available vehicle categories in the list are unselected.
Select Invert Vehicles: vehicle categories that are not selected are selected and
vice versa.

5. From the File menu, select Copy to copy the contents of the selected cells to the
clipboard.
6. From the File menu, choose Select All to select all visible cells of the table.
7. From the File menu, select Print to create a preview and optionally print the table.
8. From the File menu, select Export to print table data to a file, to Microsoft Excel or
to Microsoft Word.
9. Press Ok or Cancel to hide the form.
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9.5.3 Emission factors graph

The emission factors results are presented in a series of graphs.

To view the emission factors graph:

1. By pressing the Graph button, the emission factors results graph appears.
2. Select one or more scenarios. If more than one scenario is selected, then the
average values of the selected scenarios will be shown. From the Data menu, the
following sub-menus are available:

Select All Scenarios: all available scenarios in the list are selected.
Select No Scenarios: all available scenarios in the list are unselected.
Select Invert Scenarios: scenarios that are not selected are selected and vice
versa.

3. Select one or more emission categories. For every emission category selected, the
graph is refreshed automatically. From the Data menu, the following sub-menus are
available:

Select All Emissions: all available emissions in the list are selected.
Select No Emissions: all available emissions in the list are unselected.
Select Invert Emissions: emissions that are not selected are selected and vice
versa.

4. Select one or more vehicle categories from the third list. For every vehicle category
selected, the graph is refreshed automatically. From the Data menu, the following
sub-menus are available:

Select All Vehicles: all available vehicle categories in the list are selected.
Select No Vehicles: all available vehicle categories in the list are unselected.
Select Invert Vehicles: vehicle categories that are not selected are selected and
vice versa.

5. From the Graph menu, the user can select one of the following graphs:
VMT distribution (pie chart)
Fuel economy (bar chart)
Composite hydrocarbon (bar chart)
Composite carbon monoxide (bar chart)
Composite oxides of nitrogen (bar chart)
Composite carbon dioxide (bar chart)
Total hydrocarbon per phase (pie chart)
Carbon monoxide per phase (pie chart)
Oxides of nitrogen per phase (pie chart)
Non exhaust emissions (pie chart)

6. From the Graph menu, select Copy Graph To Clipboard to copy the bitmap to
clipboard.
7. Press the Options button to customize the appearance of the bar chart or the pie
chart (recommended only for advanced users).
8. Use the Graph menu to access the Load Graph Settings and Save Graph
Settings to create and access external settings files.
9. Press Ok or Cancel to hide the form.
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9.6 Air toxic pollutants

9.6.1 Air toxic pollutants

The user can view the air toxic pollutants results for the current project.

To view the air toxic pollutants results:

1. From the Results menu select Air Toxic Pollutants.
2. A form with a results summary per run and scenario shows up.
3. Select the target run from the drop-down list.
4. Select the target scenario from the drop-down list.
5. Summarized results are refreshed every time the user selects a run or a scenario.
6. Click on Table to view detailed calculations results in a table form.
7. Click on Graph to view detailed calculations results in a graphical form.
8. Press Ok or Cancel to hide the form.

9.6.2 Air toxic pollutants table

The  air toxic pollutants results are presented in a table form.

To view the air toxic pollutants results table:
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1. Press the Table button to view the  air toxic pollutants table.
2. Select the target scenario.
3. Select one of the following results tab:

Exhaust
Benzene
MTBE
Class 1
Class 2
Class 3
Class 4

4. From the File menu select Copy to copy the selected cells to the clipboard.
5. From the File menu, choose Select All to select all visible cells of the table.
6. From the File menu, select Print to create a preview and optionally print the table.
7. From the File menu, select Export to print table data to a file, to Microsoft Excel or
to Microsoft Word.
8. Press Ok or Cancel to hide the form.

9.6.3 Air toxic pollutants graph

The air toxic pollutants results are presented in a series of graphs.

To view the air toxic pollutants graph:

1. By pressing the Graph button, the air toxic pollutants results graph appears.
2. Select one or more scenarios. If more than one scenario is selected, then the
average values of the selected scenarios will be shown. From the Data menu, the
following sub-menus are available:

Select All Scenarios: all available scenarios in the list are selected.
Select No Scenarios: all available scenarios in the list are unselected.
Select Invert Scenarios: scenarios that are not selected are selected and vice
versa.
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3. Select one or more air toxic categories. For every air toxic category selected, the
graph is refreshed automatically. From the Data menu, the following sub-menus are
available:

Select All Emissions: all available air toxics in the list are selected.
Select No Emissions: all available air toxics in the list are unselected.
Select Invert Emissions: air toxics that are not selected are selected and vice
versa.

4. Select one or more vehicle categories from the third list. For every vehicle category
selected, the graph is refreshed automatically. From the Data menu, the following
sub-menus are available:

Select All Vehicles: all available vehicle categories in the list are selected.
Select No Vehicles: all available vehicle categories in the list are unselected.
Select Invert Vehicles: vehicle categories that are not selected are selected and
vice versa.

5. From the Graph menu, the user can select one of the following graphs:
VMT distribution (pie chart)
Exhaust emission factors (pie chart)
Benzene emission factors (pie chart)
MTBE emission factors (pie chart)

6. From the Graph menu, select Copy Graph To Clipboard to copy the bitmap to
clipboard.
7. Press the Options button to customize the appearance of the bar chart or the pie
chart (recommended only for advanced users).
8. Use the Graph menu to access the Load Graph Settings and Save Graph
Settings to create and access external settings files.
9. Press Ok or Cancel to hide the form.

9.7 Particulate matter

9.7.1 Particulate matter

The user can view the particulate matter results for the current project.

To view the particulate matter results:



Results 165

© 2012 TechnoLogismik i

1. From the Results menu select Particulate Matter.
2. A form with a results summary per run and scenario shows up.
3. Select the target run from the drop-down list.
4. Select the target scenario from the drop-down list.
5. Summarized results are refreshed every time the user selects a run or a scenario.
6. Click on Table to view detailed calculations results in a table form.
7. Click on Graph to view detailed calculations results in a graphical form.
8. Press Ok or Cancel to hide the form.

9.7.2 Particulate matter table

The particulate matter results are presented in a table form.

To view the particulate matter results table:

1. By pressing the Table button, the particulate matter results table appears.
2. Select one or more scenarios. If more than one scenario is selected, then the
average values of the selected scenarios will be shown. From the Data menu, the
following sub-menus are available:

Select All Scenarios: all available scenarios in the list are selected.
Select No Scenarios: all available scenarios in the list are unselected.
Select Invert Scenarios: scenarios that are not selected are selected and vice
versa.

3. Select one or more emission categories. For every emission category selected, a
column is added in the table. From the Data menu, the following sub-menus are
available:

Select All Particulate Matter: all available particulate matter in the list are
selected.
Select No Particulate Matter: all available particulate matter in the list are
unselected.
Select Invert Particulate Matter: particulate matter that are not selected are
selected and vice versa.

4. Select one or more vehicle categories from the third list. For every vehicle category
selected, a row is added in the table. From the Data menu, the following sub-menus
are available:

Select All Vehicles: all available vehicle categories in the list are selected.
Select No Vehicles: all available vehicle categories in the list are unselected.
Select Invert Vehicles: vehicle categories that are not selected are selected and
vice versa.

5. From the File menu, select Copy to copy the contents of the selected cells to the
clipboard.
6. From the File menu, choose Select All to select all visible cells of the table.
7. From the File menu, select Print to create a preview and optionally print the table.
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8. From the File menu, select Export to print table data to a file, to Microsoft Excel or
to Microsoft Word.
9. Press Ok or Cancel to hide the form.

9.7.3 Particulate matter graph

The particulate matter results are presented in a series of graphs.

To view the particulate matter graph:

1. By pressing the Graph button, the particulate matter results graph appears.
2. Select one or more scenarios. If more than one scenario is selected, then the
average values of the selected scenarios will be shown. From the Data menu, the
following sub-menus are available:

Select All Scenarios: all available scenarios in the list are selected.
Select No Scenarios: all available scenarios in the list are unselected.
Select Invert Scenarios: scenarios that are not selected are selected and vice
versa.

3. Select one or more air toxic categories. For every air toxic category selected, the
graph is refreshed automatically. From the Data menu, the following sub-menus are
available:

Select All Particulate Matter: all available particulate matter in the list are
selected.
Select No Particulate Matter: all available particulate matter in the list are
unselected.
Select Invert Particulate Matter: particulate matter that are not selected are
selected and vice versa.

4. Select one or more vehicle categories from the third list. For every vehicle category
selected, the graph is refreshed automatically. From the Data menu, the following
sub-menus are available:

Select All Vehicles: all available vehicle categories in the list are selected.
Select No Vehicles: all available vehicle categories in the list are unselected.
Select Invert Vehicles: vehicle categories that are not selected are selected and
vice versa.
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5. From the Graph menu, the user can select one of the following graphs:
VMT distribution (pie chart)
Exhaust particle matter (pie chart)
Total particle matter (pie chart)
Particulates distribution (pie chart)
Graph emissions of Lead, GASPM, Active carbon (ECARBON), Total carbon
(OCARBON), SO4, Total exhaust particulate matter (Total Exh PM), Tire, Brake
and Total particulate matter (Total PM) (bar chart)

6. From the Graph menu, select Copy Graph To Clipboard to copy the bitmap to
clipboard.
7. Press the Options button to customize the appearance of the bar chart or the pie
chart (recommended only for advanced users).
8. Use the Graph menu to access the Load Graph Settings and Save Graph
Settings to create and access external settings files.
9. Press Ok or Cancel to hide the form.
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10 Help

10.1 Help menu

In the Help menu you can select one of the following options:

Contents
User guide
Tutorials
Tip of the day
Unit conversion
TechnoLogismiki website
Buy products
TechnoLogismiki NOMOS
TechnoLogismiki Live!
About the program

10.2 Contents

With this option, you can access the online help which contains detailed information
regarding the usage of the program.

To view the online help:

1. Click Contents from the Help menu.
2. The online help appears.

NOTE: If an error message appears then the online help has not been installed. You
can install the online help from the installation CD or the Internet.

10.3 User guide

With this option, you can access the user guide which contains detailed information
regarding the usage of the program.

To view the user guide:

1. Click User Guide from the Help menu.
2. The user guide appears.

NOTE: If an error message appears then the online help has not been installed. You
can install the online help from the installation CD or the Internet.

NOTE: Adobe Acrobat Reader or a similar program that can display pdf files is
required in order to view or print the user guide.

10.4 Tutorials

With this option, you can access the tutorials of the program. The tutorials are step-
by-step examples that allow you to decrease the learning cycle of the programs
dramatically.
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To access the tutorials:

1. Click Tutorials from the Help menu.
2. The tutorial selection dialog box appears.
2. Select the appropriate tutorial and click Start to proceed. Click Cancel to close the
dialog box.

NOTE: The number and content of the tutorials is changed frequently. Use the live
update system of TechnoLogismiki's products to download the latest tutorials.

10.5 Tip of the day

With this option, you can access the tip database of the program. The tips are short
guidelines regarding the usage of the programs which may be of great help to the
user.

To access the tips:

1. Click Tip of the day from the Help menu.
2. The tip of the day form appears.
3. Check Do not show this form again to prevent the program from showing the tip
of the day when starting. Press the Previous/Next buttons to browse all available
tips.
4. Press Esc to close the form.

NOTE: The number and content of the tips is changed frequently. Use the live update
system of TechnoLogismiki's products to download the latest tips.
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10.6 Unit conversion

With this option, you can access the unit conversion tool. You can find more
information about its usage in its help system. 

To launch the unit conversion tool:

1. Click Unit conversion from the Help menu.
2. The unit conversion tool is launched.

NOTE: If an error message appears then the unit conversion tool has not been
installed. You can install the unit conversion tool from the installation CD or the
Internet.

10.7 TechnoLogismiki website

With this option, you can load on your Internet browser the website of
TechnoLogismiki's.

10.8 Buy products

With this option, you can load on your Internet browser the main product page of
TechnoLogismiki's website.

10.9 TechnoLogismiki NOMOS

With this option, you can load on your Internet browser the NOMOS service of
Technologismiki.

10.10 TechnoLogismiki Live!

With this option, you can load on your Internet browser the Live! service of
Technologismiki.

10.11 About the program

With this option, a form containing the name, version and licence information of the
program appears.

To show this form:
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1. From the Help menu, select About the program.
2. The form appears.
3. Click anywhere on the form or hit ESC to close the form.
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11 Tables

11.1 Vehicle categories

The 28 vehicle categories used by Mobile 6.2:

No Abbreviatio
n

Description

1 LDGV Light-Duty Gasoline Vehicles (Passenger Cars)

2 LDGT1 Light-Duty Gasoline Trucks 1 (0-6,000 lbs. GVWR, 0-3750 lbs.
LVW)

3 LDGT2 Light-Duty Gasoline Trucks 2 (0-6,000 lbs. GVWR, 3751-5750 lbs.
LVW)

4 LDGT3 Light-Duty Gasoline Trucks 3 (6,001-8,500 lbs. GVWR, 0-5750
lbs. ALVW)

5 LDGT4 Light-Duty Gasoline Trucks 4 (6,001-8,500 lbs. GVWR, 5751 lbs.
and greater ALVW)

6 HDGV2B Class 2b Heavy-Duty Gasoline Vehicles (8501-10,000 lbs. GVWR)

7 HDGV3 Class 3 Heavy-Duty Gasoline Vehicles (10,001-14,000 lbs. GVWR)

8 HDGV4 Class 4 Heavy-Duty Gasoline Vehicles (14,001-16,000 lbs. GVWR)

9 HDGV5 Class 5 Heavy-Duty Gasoline Vehicles (16,001-19,500 lbs. GVWR)

10 HDGV6 Class 6 Heavy-Duty Gasoline Vehicles (19,501-26,000 lbs. GVWR)

11 HDGV7 Class 7 Heavy-Duty Gasoline Vehicles (26,001-33,000 lbs. GVWR)

12 HDGV8A Class 8a Heavy-Duty Gasoline Vehicles (33,001-60,000 lbs.
GVWR)

13 HDGV8B Class 8b Heavy-Duty Gasoline Vehicles (>60,000 lbs. GVWR)

14 LDDV Light-Duty Diesel Vehicles (Passenger Cars)

15 LDDT12 Light-Duty Diesel Trucks 1 and 2 (0-6,000 lbs. GVWR)

16 HDDV2B Class 2b Heavy-Duty Diesel Vehicles (8501-10,000 lbs. GVWR)

17 HDDV3 Class 3 Heavy-Duty Diesel Vehicles (10,001-14,000 lbs. GVWR)

18 HDDV4 Class 4 Heavy-Duty Diesel Vehicles (14,001-16,000 lbs. GVWR)

19 HDDV5 Class 5 Heavy-Duty Diesel Vehicles (16,001-19,500 lbs. GVWR)

20 HDDV6 Class 6 Heavy-Duty Diesel Vehicles (19,501-26,000 lbs. GVWR)

21 HDDV7 Class 7 Heavy-Duty Diesel Vehicles (26,001-33,000 lbs. GVWR)

22 HDDV8A Class 8a Heavy-Duty Diesel Vehicles (33,001-60,000 lbs. GVWR)

23 HDDV8B Class 8b Heavy-Duty Diesel Vehicles (>60,000 lbs. GVWR)

24 MC Motorcycles (Gasoline)

25 HDGB Gasoline Buses (School, Transit and Urban)

26 HDDBT Diesel Transit and Urban Buses

27 HDDBS Diesel School Buses

28 LDDT34 Light-Duty Diesel Trucks 3 and 4 (6,001-8,500 lbs. GVWR)

The 16 composite vehicle categories used in registration distribution and annual
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kilometers accumulation rates commands:

No Abbreviation Description

1 LDV Light-Duty Gasoline Vehicles (Passenger Cars)

2 LDT1 Light-Duty Trucks 1 (0-6,000 lbs. GVWR, 0-3,750 lbs. LVW)

3 LDT2 Light-Duty Trucks 2 (0-6,000 lbs. GVWR, 3,751-5,750 lbs.
LVW)

4 LDT3 Light-Duty Trucks 3 (6,001-8,500 lbs. GVWR, 0-5,750 lbs.
ALVW*)

5 LDT4 Light-Duty Trucks 4 (6,001-8,500 lbs. GVWR, 5,751 lbs.
and greater ALVW)

6 HDV2B Class 2b Heavy-Duty Vehicles (8,501-10,000 lbs. GVWR)

7 HDV3 Class 3 Heavy-Duty Vehicles (10,001-14,000 lbs. GVWR)

8 HDV4 Class 4 Heavy-Duty Vehicles (14,001-16,000 lbs. GVWR)

9 HDV5 Class 5 Heavy-Duty Vehicles (16,001-19,500 lbs. GVWR)

10 HDV6 Class 6 Heavy-Duty Vehicles (19,501-26,000 lbs. GVWR)

11 HDV7 Class 7 Heavy-Duty Vehicles (26,001-33,000 lbs. GVWR)

12 HDV8A Class 8a Heavy-Duty Vehicles (33,001-60,000 lbs. GVWR)

13 HDV8B Class 8b Heavy-Duty Vehicles (>60,000 lbs. GVWR)

14 HDBS School Buses

15 HDBT Transit and Urban Buses

16 MC Motorcycles (All)

The 14 composite vehicle categories used in diesel fractions command:

No Abbreviation Description

1 LDV Light-Duty Vehicles (Passenger Cars)

2 LDT1 Light-Duty Trucks 1 (0-6,000 lbs. GVWR, 0-3750 lbs. LVW)

3 LDT2 Light-Duty Trucks 2 (0-6,000 lbs. GVWR, 3751-5750 lbs.
LVW)

4 LDT3 Light-Duty Trucks 3 (6,001-8,500 lbs. GVWR, 0-5750 lbs.
ALVW)

5 LDT4 Light-Duty Trucks 4 (6,001-8,500 lbs. GVWR, 5751 lbs.
and greater ALVW)

6 HDV2B Class 2b Heavy-Duty Vehicles (8501-10,000 lbs. GVWR)

7 HDV3 Class 3 Heavy-Duty Vehicles (10,001-14,000 lbs. GVWR)

8 HDV4 Class 4 Heavy-Duty Vehicles (14,001-16,000 lbs. GVWR)

9 HDV5 Class 5 Heavy-Duty Vehicles (16,001-19,500 lbs. GVWR)

10 HDV6 Class 6 Heavy-Duty Vehicles (19,501-26,000 lbs. GVWR)

11 HDV7 Class 7 Heavy-Duty Vehicles (26,001-33,000 lbs. GVWR)

12 HDV8A Class 8a Heavy-Duty Vehicles (33,001-60,000 lbs. GVWR)

13 HDV8B Class 8b Heavy-Duty Vehicles (>60,000 lbs. GVWR)

14 HDBS School Buses
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